Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional

Ver. 3.2

Instruction Manual

Content of this Instruction Manual

DPP is used for Digital Photo Professional.

In this manual, the windows used in the
examples are from Mac OS X 10.4.

» indicates the selection procedure of the menu.

Example: [Digital Photo Professional] menu »
[Quit Digital Photo Professional].

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

"2 : Marks helpful information when a problem
arises.

\I@/

@ . Marks information that should be read

N
/TN

before use.

Marks additional information you may find
helpful.

. Marks tips for using the software skillfully.

& Switching Between Pages
Click on arrows on the bottom right of the screen.

(O : next page
€D : previous page

: return to a page you had previously
displayed

® Click on the chapter headings on the right side

of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the “Shortcut Key List” in the Help for a
list of shortcut keys which are helpful for quick
operation.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing JPEG
Images

Reference

Index

00



Introduction

Digital Photo Professional (hereinafter, “DPP”) is high-performance RAW
image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. And
as for the RAW image, too, you cannot view it as an image on your
computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called
“development” and with EOS DIGITAL is performed using DPP.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open an image in DPP, the image is instantly developed and you can
view the image as an image to which image processing conditions at the
time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

RAW image data

Image processing conditions information
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Main Features of DPP System Requirements

Following are the main tasks you can perform with images you have

Introduction

downloaded to your computer. o Mac OS X 10.3 t0 10.4
] ) ) Computer | Macintosh with one of the above OS installed
View and organize RAW images cPU Minimum 400MHz, PowerPC G3, G4, G5 or Intel Contents at
. . ) rocessor
Real-time adjustment of a RAW image P
. . . . o CT RAM Minimum 512MB
Various image adjustments while maintaining the original image _ Basic
Freely apply a Picture Style Display ReSOIUt.'(m + 1024 x 768 or more Operation
View your image before and after adjustment in the same window Colors : Thousands or more
. . . . This software program is not compatible with UFS (UNIX File System
Trim an image and change its size o e o ogram! patible with UFS (UNIX Flle System) [ avanced
. . . Operation
: . DPP also runs comfortably on Intel-based Macintosh since it is a
Correction of lens aberration Universal application.
. . Advanced
Automatic/manual dust erasure processing e

Convert from a RAW image to a JPEG or
TIFF image and save

Supported Images

This software supports the following image types.

and Printing

_ Processing
Process large numbers of RAW images in batches Image type/Camera used Extension Lag%?nl:lgmggrs
Transfer the image to image editing software EOS-1Ds Mark 11l EOS-1D Mark IlI g
) . EOS-1D Mark I N EOS-1Ds Mark 1l
Print a RAW image EOS-1D Mark I EOS 5D Editing JPEG
. . . EOS 40D EOS 30D Images
View and organize JPEG and TIFF images EOS 20D/20Da .CR2
. . EOS DIGITAL REBEL XTi/400D DIGITAL
Real-time adjustment of JPEG and TIFF RAW images | EOS DIGITAL REBEL XT/350D DIGITAL Reference
Images EOS D6000* EOS D2000*
Various image adjustments while maintaining the original image EOS-1Ds EOS-1D TIE
Print JPEG and TIFF images EOS 10D Index
EOS DIGITAL REBEL/300D DIGITAL .CRW
Color management compatibility EOS D60 EOS D30
CMYK simulation for commercial printing JPEG images !EXIf 2.2 or 2.21-compatible JPEG JPG, .JPEG @ @
images
TIFF images | Exif-compatible TIFF images TIF, .TIFF

* Images converted to RAW images that have the “.CR2” extension in
CR2 Converter. For information on CR2 Converter, refer to Canon’s

web site.
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- Introduction

Downloading Images to Your Computer Erase dust shot with the image - p.56, p.58
Download images by connecting your cameraand ~ _, 0.6 Erase unwanted parts of an image = p.59 Cor(lzt;%nts at
computer Reduce image noise - p.52 & SIafce
Download images using a card reader - p.8 Correct lens aberration - p.53
Use a Picture Style file - p.49 Basic
Viewing and Checking RAW Images Edit efficiently -p.29 Crzgrer
Quickly enlarge parts of an image = p.10 Edit an image while comparing the image before and _, 0.45
Sort images (check marks) = p.16, p.17 after adjustment ' Advanced
_Display an image _shot simultar_leous_ly as a RAW - .19 Synchronize multiple images - p.46 Operation
image and JPEG image as a single image Display an area beyond the set range as awarning ~ _, 0.47
Display the images in the thumbnail list display at high - .20 indicator (Highlight/Shadow warning) ' | Advalgg_e_d
resolution Restore an adjusted image to its condition at the time _, 0.35 r;lnagle;rimlit;]ngg
Check shooting information such as the shooting date =» p.9, p.20 of shooting
Processing
Editing RAW Images (Adjusting) Printing Laggelr'::r;gsers
Adjust brightness{darkness =>p.11, p.22 Print well on a Canon printer = p.35, p.62, p.63
r g R e e conrf e st 0 0o pco [T
ag%rt?:;)the modulation and contrast of colors = p.25 @ Print with the shooting information = p.60 ’
Make skin tone look healthier (color tone) ->p.25 Wbrinta .thumbnail list of images _ = p.6l
Make the image colors more vivid (color saturation) *p25 Qﬁr?tri?])élrrr;astjlttst]e color seen on screen with your =» p.68 Reference
Make an image sharp (sharpness) = p.27
'(A\V\(;Igltljtset gglér:(?eg)e to make color tone more natural - p.23 Conversion of |mag es ——
Change an image to black-and-white or sepia tones 526 Co.n\./ert a RAW image to a JPEG image = p.34,p.74 -
(monochrome) Edit in Photoshop =» p.59, p.75
Trim parts of an image (trimming) = p.31 Perform batch processing ->p.74 @ @
Specify an aspect ratio that matches the size of the - p.31 Edit (adjust) a JPEG image - p.78

paper on which an image is to be printed
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1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.
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Starting up DPP

Click the Dock icon.

Digital Photo Professional

fg ¥t | N Click

DPP starts up and the main window appears.

v

Main window

Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inside the camera.
For downloading images, start up the camera software “EOS Utility”
from DPP and use.

)
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Select the save destination for the images.
Select the save destination in the folder area on the left of the
main window.
When creating a folder, refer to p.41.

Digital Photo Professii

» | A Applications
[7 Temporary Items

» [38 Desktop
» |} Documents
» [# Library

= Movies

L& Music

> | Yo
» [ Sites
» [ shared

v

Start up EOS Utility.
4= o select the [Tools] menu » [Start EOS Utility].

Tools
Start EOS Utility o 2EE

EOS Utility starts up.
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. Introduction
EOS Utility Download images.

800 EOS Utility ®e00 EOS Utility - EOS XXX

Control Camera Accessories

Control Camera Accessories Contents at
a Glance

Starts to download images Starts to download images ClICk iC
OpBe1tion
Lets you select and download images : Lets you select and download images
1 —
Camera settings/Remote shooting Camera settings/Remote shooting Advanced
Operation
Monitor Folder Monitor Folder
Advanced
- Image Editing
and Printing
Connect your camera and computer and turn the =» Downloading of images begins. S aie
camera on. »The downloaded images are saved in the folder selected in step Large Numbers
Connect the camera and your computer with the interface cable 1 and are displayed in the main window of DPP. I I
provided with the camera and turn the camera on. =» The downloaded images are sorted by date into folders and
For detailed instructions on connecting your camera and saved. Editing JPEG
computer, refer to the “EOS Ultility Instruction Manual” (PDF Images
electronic manual).
Reference
Index

00

E\@/E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.



Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card

reader.

Load the memory card into the card reader.

Open aremovable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place
such as to the [Desktop].

Digital Phota Pre

¥ 2 MacOsx
b |4 Applications

|4 Temporary Items.

¥ & Users

¥ @i canon

» [ Dedktop

» 7 Documents
¥ [l Library

* 4 Shared
¥ | EOS_DICITAL

» [0 DeiM

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

Digital Photo Professional - [ #

|4 10ZCANON

£ Travel
» |3 Documents
(il Library

# Movies

& Music
> [ Pictures
® & Public
[ Sinen

= Images in the folder are displayed in the main window of DPP.

== Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images.

@ Copying to your computer may take time when there is a large
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

Rotate selected image

Main window

. £
. EE:. _“ E-a “
- N e

vaa. v i 153, 2, v b gty e dox van S of a1 ! -

Click to select the image

Display thumbnails of all the images inside the
folder selected in the folder area on the left

|§| When aspect ratio information is attached to the shot image with
a camera where you can set the aspect ratio, the image is
displayed as a trimmed image (p.31, p.86).
For a list of main window functions, refer to p.96.

Changing the Size of Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

Edit in Edit image window o6 —

v Folders

v Toolbar
Tool palette #T
Large thumbnail E

v Medium thumbnail 862
Small thumbnail 33

Thumbnail with information 364

Sort >

=» The display changes to the selected item.

)
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Enlarge and View an Image in the Edit Window

Double-click
The edit window appears.
Edit window Tool palette
606 .. Digital Photo Prafessional - [ MacOSX fUsers fcanon) Pictures | Photo xxor o xo IMG_0001.CR2 | TR e, N

(1374, 570): 244, 245, 244 High quakty

AW | Adobe RER CMYE -

It may take time for the image to redraw itself.

Click the [@®] in the upper left of the window to close the edit
window.

|§| For a list of edit window functions, refer to p.98.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

W FV )+ Digial Phate Professional - | MacOsx [Users (anon Pectures | Fhats) xaus_xx_xx /IMG_0001ORZ |

BAW | Adksbe BCE CUYE

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

® Double-click again to revert to the full view.

® To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

== To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.66).

)

Introduction

Contents at
a Glance

ic
Opernation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing JPEG
Images

Reference

Index

00
©

10




Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [ ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
———{ Raw RGB  NRiens ——|
|Eﬁ'9hmess adjustment [ s [— Reverts the image to
——fo "0 the original settings
: = Drag the slider left or
|Whﬂe balance adjustment | i| .
SV right
E 1 2 3 P.;‘:r!!'ill:i'_
Shot settings J $] ¥ Tune; %
|Picture Style [ *= |
_ Standard J $] { Browse... )

- ~

h—-iD_U -850 -6.0 -40 =-20 0 20 4.0

Caontrast:

{D] 1 1 1 I .\-? 1 1 1 1
| Linear

{chllur tune 1 1 1 1 v 1 1 1 1

Color saturation:

{D] ] 1 1 I (? 1 1 1 1

Sh :
{l]arpness —I—G 1 1 ] I 1 1 1 1 1

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.71).

ﬁl For a list of tool palette functions, refer to p.99.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window HEW
[ save %S
Save As... i 35
Convert and save... ®D
Page setup... {r 3P
Print... P
Print with detailed setting... {r3D
Contact Sheet Prints... ~3EP
Plug-in printing 2
Info... |

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Save (p.33)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.33)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.20)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.34)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process* (p.74)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

You can save * in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HEW
Save 3£5
Save As... i3S
Convert and save... ®D
Page setup,.. it P
[ Princ.. 3P )
Print with detailed setting... 13D
Contact Sheet Prints... ~3EP
Plug-in printing |
Info... £

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-Z\@/i— To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.

Print one image (p.40)

Print with a Canon inkjet printer (p.35, p.38, p.62)

Print with shooting information (p.60)

Printing a thumbnail list (contact sheet printing) (p.61)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu P [Quit Digital Photo
Professional].

Digital Photo Professional

About Digital Photo Professional
Preferences... 3,
Services [
Hide Digital Photo Professional 3H
Hide Others NC3EH

wAll

[ Quit Digital Photo Professional EEQ]

=» DPP quits.

"2 Quitting DPP without saving adjustments to images

A confirmation dialog box for saving the images appears. Select [Yes to
all] to save the adjustment contents (recipe) to all the images adjusted.
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D Advanced Operation

Introduction
A more advanced operation — from efficiently checking multiple images, Editing Efficiently ... 29
to various ways of e_zditing an ?mage, printing a RAW image with a Canon Changing the Thumbnail Display Position to a Horizontal Contents at
printer and sorting images —Is explained here. POSItION ..ot 30 atlnze
Efficiently Checking/Sorting Images..............c.......... 15 Trimming an IMage...........cocoeiiiiiin 31 -
SOrting IMAJES. .....uvveeeeeeieciieeee e 16 Applying Adjustment Contents to Other Images...... 33 Operation
Sorting Images in the Main Window ..................... 17 Saving Editing ResUlts.............cccccociiiiiiniiieee, 33
Arranging Images in the Main Window...................... 17 Saving Editing Contents to a RAW Image.................. 33 Ad@ed
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into three groups.

Click the [Select all] button on the toolbar.

The color of the image frame around all the images changes.

Display the quick check window.
Select the [Tools] menu P [Start Quick check tool].

Tools

Start EOS Urility S a3EE
Transfer to Photoshop 3P

[ Start Quick check tool  C3F |

Start Trimming tool HET
Start Stamp tool \3S
Start Rename tool R

Sync folder with EQS Utility

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

w2715 IMC_D002.CR2 (3456 x 2304]

The area you double-clicked is enlarged to 50% view.
Double-click again to revert to the full view.

To change the display position, drag on the image.
To quit, click the [OK] button.

)
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AL/

> Convenient functions of the quick check window

To check all the images, do not select an image in the main
window

When step 2 is performed with no image selected in the main window,
you can check in the quick check window all the images that were
displayed in the main window.

Switch between images using the keyboard

You can also switch between images by pressing the <—> or <«>
keys on the keyboard.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

|§| The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.66).

For a list of quick check window functions, refer to p.101.

Sorting Images

You can sort images by attaching three types of check marks for each
subject or theme.

Attach check marks for sorting.
Check mark

2715 IMC_0002.CR2 (3456 x 2304]

-~

= The selected check mark appears in the upper left of the window.
@ Click the [Clear] button to remove the check marks.

)
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Sorting Images in the Main Window

You can sort images by attaching three types of check marks in the main
window.

In the main window, select the images you want to
sort and attach a check mark for sorting.

Bs/Photo/xxxx_xx_xx ]

Check mark

The selected check mark appears in the upper left of the image
frame.
Click the [Clear check] button to remove the check marks.

Vs

5@3 To select multiple images in the main window

Click on desired images while holding down the <g8> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu P [Sort] P desired item.

Edit in Edit image window *—
v Folders
v Toolbar
Tool palette ®T
Large thumbnail #*1
v Medium thumbnail &2
Small thumbnail #*3
Thumbnail with information 34

A T e rame

RAW priority

Check mark 1
Check mark 2
Check mark 3

Shooting Date/Time

The images are arranged in the order according to the selected
item.
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Sort item

Check mark1 -
Check mark3
Shooting Date/Time

File name

RAW priority

Description

Images with check marks take priority and are
sorted in number order.

Images are sorted by shooting date and time
from the earliest.

Images are sorted by file name in alphanumeric
order (Oto 9 » Ato 2).

Images are sorted in the following order: RAW
images - JPEG images - TIFF images.

-I\@/i— Check mark order

When you have attached check marks 1 to 3, the images are sorted as
follows: If you select 1, the order is 1-2-3; if you select 2, the order is
2-1-3; if you select 3, the order is 3»2->1.

Arranging Freely

Drag and drop the image to the desired location.

L;- 12152 1y W meom d Mmoot g 13 St of e s |

» The image moves to the desired location.
@ You can also select multiple images (p.17) and move them.
© The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.
©® Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

E@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in Preferences to maintain
the order of images without changing the image file names (p.66).

Maintain order and change image file names

You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.76).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

Preferences

+ General settings l View settings l Tool palette Color management -

Grid pitch
" 64 Pixels(3-256)

Locking selected image
# Images opened in Edit window remain selected in main window

Magnification in Edit window

vl

¥ Fit to window O 50% O 100% O 200%

Magnification when the Edit/Edit image window is double-clicked

() 50% @ 100% () 200%

[
' ™ Display only CR2 images for CR2 and JPEG files of the same name ]

Sort order in main window

" Retain sort order

Highlight/shadow warning

Highlight 192 n9z-2550 [
Shadow 0 (0-64) . 11 = =N}

Quick check tool display

® s0% ) 100% (moiré reduction off)

Cancel f 0K 3

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [ZXB] mark (p.97).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

E\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

» Deleted an image (p.41)

* Moved or copied an image (p.42)

e Checkmarks (p.16, p.17)

» Rotated an image (p.96, p.101, p.102)

 Attached a thumbnail to an image and saved (p.20)

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

Open in Edit window... #O
Open in Edit window (enlarged)...
Close window FHEW
Save #5
Save As {1388
( Add thumbnail to image and save QxT]
Convert and save... #D
Batch process... #B
Create new folder... {r 3N
Page setup... {+ 3P
Print... #P
Print with detailed setting... {+3#D
Contact Sheet Prints... ~¥P
Plug-in printing >
Delete E gl
Info... |

== The extent of the improvement in quality

The quality improves the most when [Large thumbnail] (p.9) is selected.
When [Medium thumbnail] or [Small thumbnail] is selected, the
improvement in quality may be hard to tell due to its size. The quality
also improves for JPEG and TIFF images.

|§| A large number of images may take some time to add.

-

Checking Image Shooting Information

Select the image for which you want to check the
shooting information.

Select the [File] menu » [Info].

Open in Edit window... #0
Open in Edit window (enlarged)...
Close window HEW
Save 35
Save As... {r 385
Add thumbnail to image and save {3T
Convert and save... #D
Batch process... 3B
Create new folder... {r3EN
Page setup... {r3EP
Print... 3P
Print with detailed setting... {+3D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Delete F |
L info... 2 )

The image information window appears.

Ay
N

@< Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the shooting information for that
image will be displayed.

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnail with information] (p.9).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the [[ 5]
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window Tool palette
BN A Digital Photo Professional - [ MacOSX fUsers feanon /Pictures Photo) oo xx(IMG_0001.CR2 | s - -*-::-tv‘m
4
Tt setinge .
i s
Standurd Ir' Browie

AW [ Adobe RCE CWVE 7 |

(1374, 5T3): 248, 345, 244 High quakty

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, press the <3 > + <Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.45).
You can synchronize multiple images and edit while comparing
them (p.46).
Refer to p.98 for a list of edit window functions, and p.99 for a list
of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens] tool palette are explained in Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tools] button (p.96) in the toolbar on the main window,
the same tool palette that appears in the edit window is displayed and
you can edit images.
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Adjusting Brightness

Brightness of an image can be adjusted. Move the slider to the right to
make an image brighter and to the left to make an image darker.

————| RAW | RGB NR/Lens | .
e Reverts the image to
e ([ ® || the original settings
e (- .
rrrrrer el Iml rrrrrenrnd I"}I:”:I _Entera numerlcal
White balance adjustment | | value

| J . =

1 | 2] 3 |Cregister..

Shot settings | :] P Tuna:Y

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you select [Monochrome] and have saved (p.33) the image, you
can always revert to a color image by selecting a Picture Style other
than [Monochrome].

‘F‘icture Style [| - Jﬂi Reverts the image to
the original settings
[ Standard f :]]L'r Browse...
- = = Select

i k L

A 3

OGN = 4

.0 =80 -6.0 4.0 =&0 0 2.0 4.0

Contrast: r—
{U] 1 1 1 1 (? 1 1 1 I
[ -] Linear
lor tone: =
cu 1 v 1 1 1 1

{00} aniia
Color saturation:

{u] ] 1 1 1 (? 1 1 1 I
Sharpness:
(1] .I_Q ] 1 1 1 I ] 1 1 1

|§| Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast] and

[Sharpness] settings, even if you change the Picture Style (p.67).
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Picture Style

Standard

Portrait

Landscape

Neutral

Faithful

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

The image looks vivid.

Ordinarily, this setting is suitable for most images.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.25).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.26).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [ ].

Picture Style File

A Picture Style file is an extended function of Picture Style. It is a file that
offers effective image characteristics for an image shot in an extremely
limited scene. Refer to p.49 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

---------- —{  Raw RGE | NRlens

|Efighrness adjustment IHP.....-'|
B S 0.00

|Whita balance adjustment [. B [— Rever_ts_ the lmage to
L L EAYE the original settings
[ Shot settings =

Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.24).

AL/

Q= Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.25) to get closer to your
requirements.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

——— RAW | RGBE  NRiLens |
|Erighmess adjustment = |
|||||||||||m||||||||||| G-I:”:I
|While balance adjustment = |
¥ noncaT W
g : Click
| Shot settings I :}l: Tune... :I

Click on a point that is to be the standard for white.

_ - P ToCRE [alakal ] D000 =
GIala) = gl [ e [

12230, 1285 ) 109, V16, 133 RAW [ Adsbe BER CMVE

‘ Click Reverts the

The coordinates of the cursor position and the ~ image to the
RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

)
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

| Picture Style

(= .]l— Reverts the image to
the original settings

|$]|," Browse...

% “d

Standard

r.--il}'_ifl =50 -6.0 -40 =20 0 20 4.0

Contrast:

—— Drag the slider left or

e T Sl right (9 steps)
 Linear

E;:].Iurturre: s 6’ A

E:::Inr saturation: R

{s{.larpness: ‘T@I R e

Display the value of the setting

-I\@/E [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.22) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.26).

‘ Picture Style

Q_?_m— Reverts the image to
the original settings

|$]|," Browse...

[ “

Standard

A
! P b
PR
| b e A
100 T30 6040 -20 0 20 40

Co - — -
(u}ntraS[ 1 1 1 1 t? i 1 1 I
- W = Drag the sliders left
= : p rag the sliders left or
{D‘:]I R I 1 1 |l f? ,I 1 1 1 rlght
el (Y
Color saturation:
(n]— ] ] U Il ,I 1 1 I
Sh H
{]_}arpness T@ ] 1 1 1 I ] 1 1 1
Display the values of the settings
Color tone: Mainly used for adjusting skin tones. Move the

slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

ﬁl The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.22) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box
(p.22).

[ [=] Reverts the image to
the original settings

Monochrome i#]f' Browse... \l

o 4

rh—-llf!.lfl =30 ~6.00 4.0 =20 0 20 4.0

Contrast: =
{0 (ROEe T Tt V TR

| Linear .
Filter effect: (5'5‘ prag the sliders left or
(None) ) ! : ! rlght
Toning effect: 3

{Mone)

2
Sharpness: 6

]

Display the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.
Blue sky is reproduced more naturally and white
Yellow
clouds emerge clearly.
Oranae Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

© Toning effect: You can create a single-color monochrome
photograph to which color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

:@5 Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] (p.25) slider closer to
the right.
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Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.
Move the slider to the right to make an image harder and to the left to

make an image softer.

| Picture Style

[[EJII— Reverts the image to

Standard

|¢]( Browse... :I

"

4

100 B0 -60 -40 -Z0

Caontrast:
{U] I 1

[ Lingar

Calor tone:
{0] 1 1

Calor saturation:

{0 1 1

Sharpness:

{:!_] @IIIIIIII

Display the value of the setting

the original settings

!
Drag the slider left or right

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness may seem unnatural.

|§| The adjustment range is 0 to 10 (in 1-stop increments).
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.109). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

—————  raw || reB ] NRiLens |
‘TE’"‘ AL I | I+ |Z» {—— Reverts the tone curve
Tone curve adjustment [+ | to the original settings
e - ]+
255 | Vi High
Standard
0 . |
o 255
Eﬂghtﬂess (AR AR R R RN R Dz
cuntraSl- trnrrrerryrrrrrneent D?
Hue L ey ey |‘r?r‘! Dz
Saturar“}n ety erene Lgi lDD 3
Sharpness: Q—m,: 0 ?

The tone curve changes as adjusted.

A/

~@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

(D It you click the [(E2®]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.82).
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Editing Efficiently
The thumbnail display and the edit window are combined and images can

be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

Select all Clear all

Click

The main window switches to the edit image window.

Edit in the edit image window.
Change the size

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

=* It may take time for the image to redraw itself.
The same tool palette as in the edit window is displayed and you
can edit the image.
To revert to the condition before the last operation performed on
the tool palette, press the <38> + <Z> keys.
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Double-click the area you want to enlarge.

Tan_View  Admitmert Tooh  Window heip
= Diptal e Professianal - [MacOSX Uers (canan Pnures, Phato e xx.x G009 O |

Double-
click

AL 000 T, 4 gt uinny AW | hde RCH AR

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view ([Fit to window]).

To change the display position, drag on the image or drag the
enlargement display position (p.99) of the tool palette.

To return to the main window, click the [Main Window] button on
the toolbar.

-2\@/3 To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.67).
You can change the enlargement ratio when you double-click

(p.66).
For a list of edit image window functions, refer to p.102.

Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

slomal File Edin  Veew Adjusimenst  Tools  Window  Help
Digital Photo Professional - | MacOSX /Users canon/ Pictures | Photo IMG_O00).CR2 |

41 Wed 11:17AM @

® If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information.

Select the image to be trimmed.

Open the trimming window.
Select the [Tools] menu » [Start Trimming tool].

Tools

Start EOS Utility A
Transfer to Photoshop  “C#P

| Start Trimming tool HT |
Start Stamp tool CHRS

The trimming window appears.
When the image has redrawn itself, select a ratio and
drag the trimming range.
Trimming window

BIrE # 1/1 MG 0001.CR2 [3456 x 2304]

Full screen

(e C == D—Cancel

Select a
. C— trimming
e ratio
i Drag the
Opacity . .
= e trimming
range

NG S04 15 3026, 1ENO ) = (1969 x 132611 190

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can freely trim an image.
[Custom]: You can trim an image at the specified ratio.

4 Click the [OK] button to return to the main window.
» The trimming range frame is displayed in the trimmed image
(p.97).
When the trimmed image is displayed in the edit window or the
edit image window, it is displayed as a trimmed image.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.35).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.97).

 Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.34).

Images that have aspect ratio set display as trimmed images
When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information. However, since the
image is not actually trimmed, you can change the trimming range or
revert to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.104).

~
-

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

ﬁl For a list of the trimming window functions, refer to p.104.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.71) can be saved as a separate file from the image
and loaded and applied to another image (p.72).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.31) range information can be saved to a RAW image or to a
separate RAW image.

Also, each adjustment made with the tool palette (p.48 to p.53) and dust
erase contents (p.56 to p.59) explained in Chapter 3 can also be saved
to a RAW image.

Select the [File] menu » desired item.

Open in Edit window... #0
Open in Edit window (enlarged)...

nsé Al
op indow
Close window HEW
sSave 35
Save AS... {+ 385
Add thumbnail to image and save {3T
Convert and save... #D
Batch process... 3B
Create new folder... 3N
Page setup... {r3EP
Print... 3P
Print with detailed setting... {+3D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Delete * &
Info... E:d|

Your adjustments are saved to the image.
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Introduction

Saving as a JPEG or TIFF Image Specify the necessary settings, and then click the
To vi dit and print a RAW i ith soft ther than DPP. [Save] button.
0 view, edit and print a image with software other than : : , .
convert to a more versatile JPEG or TIFF image and save. By default, the image is converted and saved to a JPEG image SO el
with the highest image quality, without changing the image size. a Glance

The image is saved as a separate image, so the RAW image remains

Change the settings according to your requirements.

unaffected.
: Convert and save BaSi(.:
Select the image to be converted. ((save as: (opeo0r |(=) }—{— Enter afile name Operation
( Where: | [ Photo |C] '7— Select the save
Select the [File] menu » [Convert and save]. Fle formar destination Ad™ced
(Kind of file Exif-JPEG ) }—— Select an Image type Op ion
Image gquality . e _ R e 10
Open in Edit window... #O Qutput setzialll
Open in Edit window (enlarged)... oupu el 3500 sz;s e anareed
Resize setting —_ Image Edltlng
: | Resize : _ and Printing
Close window EW Ll il Lnic
| 3504 | x 2336 pixel W ¥
{3504 pixel ) { 2336 pixel )
:232 s Q:Z ' Lock aspect ratio Process|ng
_ . Large Numbers
; : ( Cancel ) Save —— Click and save ng Images
Convert and save... D
Batch process... B =»The RAW image is converted to a JPEG or TIFF image which is
Create new folder. .. SN then saved as a new image in the specified save destination. Editing JPEG
Images
Page setup... {+ 3P
Print... P
Print with detailed setting... {+3D
Contact Sheet Prints... ~ 3P Reference
Plug-in printing >
Delete #&
Info... £
] Index
The [Convert and save] window appears.

dust-erased image explained in Chapter 3 (p.56 to p.59) actually

becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which @
occurs when you convert and save an image as a JPEG (p.64).

You can batch convert and save multiple images (p.74).

For a list of [Convert and save] window functions, refer to p.103.

ﬁl By saving as explained on this page, a trimmed image (p.31) or @ @
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.21), so the “original image data itself” remains
unaffected. Also, the trimming range information of a trimmed image
(p.31) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.33) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate Left 3EL
Rotate Right 3R
Add check markl HF1
Add check mark2 HF2
Add check mark3 3EF3
Clear check mark 3 F4
Work color space >
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings 3#Z
Revert to shot settings ~37

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with the Canon inkjet printers compatible with the Canon printing
software, Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how
to print photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.38)
Printing Photographs with a Printer other than the Canon Inkjet
Printers (p.40)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint EX
(hereinafter, “EPP EX”) :
Simple printing of RAW images
Printing with faithful colors
® High quality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.

Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint EX].

Print with Fasy-PhotoPrint

38F

Print with Easy-PhotoPrint EX

Open in Edit window... E40]
Open in Edit window (enlarged)...
Close all
Close window #W
Save #S
Save As... 1+ 3S
Add thumbnail to image and save {3T
Convert and save... #D
Batch process... #B
Create new folder... {+ 3N
Page setup... {+ 3P
Print... P
Print with detailed setting... {+3D
Contact Sheet Prints... ~HP
(] D ]
Delete <&
Info... 9|

EPP EX starts up.

In the EPP EX window, select the [File] menu p

[Preferences].

My Recent Files >

Next step

Preferences...

The [Preferences] window appears.

In [Print Quality], select [Quality Prlorlty]

6 0.6 Preferences
Print 1 Advanced
Number of copies : 1 ; Copies
Printing Order By Date ]

ar|Bar u

Amount of extension of borderless printing Default

Print Quality (w])—_* Se|eCt
(Option.. ) Quality
Priority

( “Help ) ( cancel ) ( oK )

Click to close the window

Specify the number of sheets to be printed, and then

click [Select Paper].
EPP EX

CIEXE) Mew Phata Print - Easy-FhotoPrint EX

 COpHes 1 DN H0F ach image.

Pheoto Pring

[@ satect Paper

Exif Print

Click to
increase the
number of
sheets to be
printed

)
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Select the paper type, and then
Print] button.

click the [Layout/

CIEXE) Mew Phota Print - Easy-PhatoPrint EX

‘Select e prisier 13 use, Tien select e 50w 4nd hpe o paper 1o prning
Pheoto Pring

Ganen 106K

Exi Print

Letrer at eo-n ~ Sy
5 [

Select the
/ paper type

Help. |

Click

Specify the layout, and then click the [Print] button.

Bew Phata Print - Easy-FhotoPrint EX

Sk B Prird Butn,

Exif Print

=Ty

Help i} e

Click to print
Printing begins.

Select the
layout

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
The printed image’s color is not what you expected

Change the [Rendering intents when using Easy-PhotoPrint] (p.68) to
[Perceptual] (p.110) and print.

ALy

-@> Advantages of printing with EPP EX

Printing with faithful colors
When the color space (p.110) is set to SRGB or Adobe RGB (p.59,
p.68), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.
If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

® Printing with a wide color reproduction
When the color space (p.59, p.68) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.62).

)

Introduction

Contents at
a Glance

Basic
Operation

Advaficed
Op ion

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing JPEG
Images

Reference

Index

37



Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint (hereinafter,
“EPP"):

Simple printing of RAW images

Printing with faithful colors

High quality printing using the color reproduction range of Adobe RGB

and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer.

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint].

Open in Edit window... #O

Open in Edit window (enlarged)...

Close window EW

Save 35

Save As... {r 35S

Add thumbnail to image and save {r38T

Convert and save... #®D

Batch process... *B

Create new folder... {r3EN

Page setup... 1+ 3P

Print... £

Print with detailed setting... {+3D

Contact Sheet Prints... ~ %P Y
0 W] 0 P 3 PnotoP I

Delete * &

Info... k1

EPP starts up.

In the EPP window, select the [Easy-PhotoPrint]
menu » [Preferences].

Easy-PhotoPrint

About Easy-PhotoPrint...

(

Preferences... 2, )

Services >

Hide Easy-PhotoPrint 3H
Hide Others HEH
Show All

Quit Easy-PhotoPrint  3Q

In [Print Quality], select [Quality Priority].

The [Preferences] window appears.

Preferences

.

=

Print Number of copies : |1
Printing Order : By Date
Amount of extension of Default

borderless printing :

Print Quality :

[ Quality Priority

®

( Defaults )
cancel ) 0k

— Select

Quality
Priority
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Select the [Advanced] tab sheet and cancel the EPP
image compensation function.

Preferences

[ )
{ Print | Advanced

Image ptimize images automatically CIICk to
EApply Rotate/Trimming to the same images in the same manner remove

check mark

When landscape images are rotated depending on the selected
) Rotate Left

) Rotate Right

Layout ] Always trim when you select the layout with the margins

ES&t margins to the minimum when you select the layout
with the margins

E Print filename when you select the index in layout

E Preview all layouts of A4 and Letter

Image [ Select images from multiple folders
Selection

@ ( cCancel ) 'f—eli-—;l
|

Click to close the window

Specify the number of sheets to be printed, and then
click [Next].

Click

Click to
increase the
number of
sheets to be
printed

Cancel the image compensation function, select the
paper type, and then click [Next].

Click to remove check marks

866 Eazy-Photofrint
—

Select the
paper type

it ot e as 19 Pupae S A4 P Typa Pt P Pro 13 punia)

8 Specify the layout, and then click [Print].

806 Lary-Fhotofrint

Click to print

N N el b e P I Wil

Select the layout

=» Printing begins.
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? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
The printed image’s color is not what you expected

Change the [Rendering intents when using Easy-PhotoPrint] (p.68) to
[Perceptual] (p.110) and print.

A/

Q> Advantages of printing with EPP

Printing with faithful colors

When the color space (p.110) is set to SRGB or Adobe RGB (p.59,
p.68), this color space is automatically transmitted from DPP to EPP,
allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.59, p.68) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.62).

Printing Photographs with a Printer other than the Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

Open in Edit window... #0
Open in Edit window (enlarged)...
Wi
Close window HW
Save 35
Save As... {+36S
Add thumbnail vo image and save {+3T
Convert and save... #D
Batch process... B
Create new folder... {r3EN
Page serup {3 3EP
L Print.. 2P )
Print with detailed setting... irdeD
Contact Sheet Prints... ~3P
Plug-in printing >
Delete 3 <&
Info... £

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

Open in Edit window... #0
Open in Edit window (enlarged)...

Close window FHEW
Save #5
Save As... {35
Add thumbnail to image and save 3T
Convert and save... #D
Batch process... B
Create new folder... 3N
Page setup... {r3EP
Print... #P
Print with detailed setting... {+3#D
Contact Sheet Prints... ~3P
Plug-in printing »

( Delete St]

Info... Eq

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted from your computer by selecting the
[Finder] menu » [Empty Trash] on the desktop.

Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new
folder is to be created.

Digital Photo Professi

¥ 2} MacOSX

» [ Applications
[ Temporary Items
v [ Users
v @ canon
» [@ Desktop
> Documents
» [# Library
= Movies

(& Music

v "
b —

» [ sites
» [ Shared

") Select the [File] menu P [Create new folder].

Open in Edit window... *0
Open in Edit window (enlarged)...

Clo

Close window HEW
Save 35
Save As... {385
Add thumbnail to image and save 43T
Convert and save... 3#ED
Batch process... 3B
Create new folder... QaﬂN)
Page setup... {r3EP
Print... 3P
Print with detailed setting... {+3D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Moving Images in Folders

You can move or copy folders that contain images, and sort the images

)

Introduction

Contents at

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination
folder.

Digital Photo Professional - [ &

v 5
* A Applications
Temparary Items

[ Teavel

* 3 Documents
» M ubrary
# Movies

The images are moved or copied to the destination folder.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the Basic
Operation

Advaficed
Op ion

destination folder.
To copy: Drag the folder while holding down the <option> key

and release when the folder is in the destination folder.

Digital Photo Professional - [ M

v 5 Macosx
* 8 Applicatrons
£ Tempaorary ltems
v 4 ey
¥ & canon
» Ol Desktop
[0 Travel
» | Documents
» K Library
(¥ Movies
L meic

=» The folders are moved or copied to the destination folder.
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Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

ann Digital Photo Professianal - [ b

» |3 Documents
» B Library -
¥ Movies @ MGO00LCRE
k

T ) )
EStimags  Fobders Sbitall - Cleas al
» |4 Applications |-
[ Temparary tems e |
¥ & Users -
¥ & canon #
> Ol Deskiop
Travel
]
{r+i]

Select

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu P [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Introduction
Various preferences including advanced image adjustment, automatic Transferring a RAW Image to PhOtOShOp ________________ 59
dust erasure processing, various printing functions for printing out work, .

P g printing prifnting out W Setting Work Color SPace ..........cccceeeveveeeeeeeeenne. 59 | Contents at
and color management are explained here, geared to the user who is o _ _ _ a Clance
competent in the handling of third-party image editing software. Printing with Shooting Information........................... 60

Printing a Thumbnail List (Contact Sheet Printing) .. 61 e

Adjusting While Comparing with the Original Image... 45 Printing RAW Images on a High-End Canon Printer.. 62 Operation

Changing How the Window is Split................cooeeee. 45 Printing with a High-End Canon Inkjet Printer ............ 62
Adjusting by Comparing Multiple Images................. 46 Printing with a Large-Format Canon Printer ............... 63 Advanced
Displaying an Area Beyond the Set Range as a Specifying Preferences..........cccccceiveiiiviiiiiieeceeinnnnn. 64 Seeer
Warning Indicator (Highlight/Shadow Warning)....... 4t General Settings...........ccccooeiiiiiii e, 64 AdvEmced
Performing Advanced Editing................c.cccovevvee 48 VIGW SEHINGS ..o oot 66 'gwnadg?g;;;gg
Adjusting White Balance with Color Temperature ..... 48 TOOI Palette ...oooiiveiiie e 67
Tuning White Balance with Color Wheel .................. 48 COlor ManagemMent.............c.ccuovveeeeeeeeeeeeeeeeeeee e 68 |, Processing
Adjusting Dynamic Range ...........cccvvvvvvniiieeeeeeeeeeisinns 49 La;%elr'::rggg ©
Using a Picture Style File.........cccoovivieeeeeeescieceiie s 49 R
Tone Curve Adjustment.........ccooeeeeiiieiiiiiine e ceeeeeiinns 50 EdiltmggJezEG
Example of a Tone Curve Operation ..................... ol
About the RGB Tool Palette ...........cccoeeveieiiiiiiiiiiinnnnn ol
REAUCING NOISE ...t 52 Reference
Correcting Lens Aberration .........cccooeevveviiiiiieveeennnnnn. 53
Compatible Cameras............ccccocviiiiiiiiiii, 53 Index
Compatible LENSES.....ccooiiiiieii 53
Making CorreCtionS..........ueveeeeeiiieeiiiiee e 24
Performing Automatic Dust Erasure Processing...... 56 @ @
Automatic Dust Erasure Processing in the Main Window.. 57
Manually Erasing Dust (Repair Function) ................ 58 @

Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION) ..o 59 44



Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/
after comparison].

Lo s e nn v ey

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.
Select the [View] menu » [Change up/down/left/right] » [Up/
downl].

[ZXals) = Dl P

F— o

The arrangement of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same
operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Display
mode] P [Split single image].

Do P osfeiionsl | a8 e e Tt P v v e R GO TR

)
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© To switch between top and bottom, and left and right, perform the
same operation as step 2 on the left page.
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Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
windows, the enlargement display position will also change in the
In the edit window, display the multiple images to be other edit windows.
compared. To cancel synchronization, select the [Window] menu »

Align the images [Synchronize] again.

Align the images for easy comparison.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.
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The other edit windows will also be displayed in the same
position/enlargement ratio.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the

Introduction

image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select Corg}tlents at
in red and the shaded part in blue. [Shadow]. ablance
On the opened image, if there is an area that exceeds the value
Select the [Digital Photo Professional] menu » entered in step 3, the highlighted part of that area is displayed in Basic
[Preferences]. red and the shaded part is displayed in blue. Operation
Select the [View settings] tab sheet.
Advanced
Operation

Enter the warning range for [Highlight] and

[Shadow].
) Advapced
Preferences |mag |t|ng
and Pfinting
+ GCeneral settings View settings | Tool palette Color management -
Grid pitch Processing
54  Pixels(8-256) Large Numbers
Locking selected image Of Images
E Images opened in Edit window remain selected in main window
Magnification in Edit window _ail
@ Fit to window O 50% O 100% ) 200% Editi ng JPEG
o . : . : , Images
Magnification when the Edit/Edit image window is double-clicked 3
O s0% ® 100% O 200% l
RAW and JPEG
# Display only CR2 images for CR2 and JPEG files of the same name Reference
Sort order in main window
| Retain sort order
Highlight/shadow warning
Highlight 192 | woz-zss
St o] oen  E— Index
Quick check tool display R E———
@ 50% ) 100% (moiré reduction off)
Cancel \ f 0K ') @ @
Click the [OK] button to close the window. @

@ You can also display the warning with the same operation in the edit

image window.
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Performing Advanced Editing

. . . . . Introduction
This section explains how to use the advanced adjustment function on

the tool palette in the edit window Tuning White Balance with Color Wheel
Adjustments made using the high-level functions of the [RAW] and White balance can be tuned by moving a cursor in the color direction
[RGB] tool palettes, as well as the functions of the [NR/Lens] tool palette shown in the color wheel. Cg’gg‘rfgeat
are explained in this section.
In the [RAW] tool palette, click the [Tune] button.
. . . . Basic
Adjusting White Balance with Color Temperature Operation

Tune by dragging a point.

White balance can be adjusted by setting a numerical value for color — T
temperature. e ite balance fine adjustment

_ Advanced
. ke — Enter the values Operation
Select [Color temperature] from the [White balance Color saturation: to set

adjustment] list box.

Ad\%(j:ed
Imag iting
Set the color temperature. =T and Phting
R TR |
—{ Rraw RGE | NRiLens Drag .
‘Eﬂ'ghmess adjustment = |‘ Processing
it Large Numbers
IIIIIIII'IIMIIIIIIII'II GDD Oflmages
‘While balance adjustment | = |‘
= 1 | 2 [ 3 | Register... ) Editing JPEG
Images
( Color temperature I:] Tune... :I
; .
v (5200 k)——+— Display the value of the
) ) setting Reference
Drag the slider left or right
Index
@ The adjustment range of color tone is 0 to 359 (1 unit in numerical @
value input), and the adjustment range of color saturation is 0 to 255
|§| The adjustment range is 2800 to 10000K (in 100K units). (1 unit in numerical value input).
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Introduction
Adjusting Dynamic Range Using a Picture Style File
Dynamic range (width of gradation expression) from dark points to bright A Picture Style file is an extended function of Picture Style. It is a file that
points in an image can be adjusted. offers effective image characteristics for an image shot in an extremely 2 Glance
limited scene. With DPP, you can apply a Picture Style file to a RAW
: image.
[FE s (2] Move downwards You can use a Picture Style file effective for the scene, downloaded from Basic
Standard B Browse... ) Outout hiahliaht points the Canon’s web site or your original Picture Style file created with Operation
. « P ghlight p “Picture Style Editor” (Picture Style file creating software). When using a
Picture Style file, save it to your computer beforehand.
B : Move to the left or right Advanced
: Input highlight points Select the image to which a Picture Style file is to be ke
e ——— e applied. A y
: . ce
E;:]mtrast. R, v SRS P Click the [BI’OWSG] button. |ma931i-ting
_ Linear Move upwards = > The [Open] dialog box appears. and Pfinting
Color tone: Output shadow points . L
© o Y P P Select a Picture Style file. e
S =" -3 The Picture Style file you selected is applied to an image. Large Numbers
h : of Images
‘{Sl]arpness ‘._6 T
Move to the left or right Editing JPEG
Input shadow points Images
The horizontal axis shows the input level and the vertical axis
shows the output level. Reference
Index

|§| The Picture Style files that you can apply to the camera are files with @ @
the “.PF2” extension only. Furthermore, you cannot apply Picture @
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will

display correctly. 49



Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by

changing the tone curve (p.109).

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation

method.
— RAW [RGB~ NRiens |
|Tnne CUrve assist O+ E2e
Tone curve adjustment ]
RGB R lc| s 2]
- e I — L .'l
255
¥ Curve
Straight
v RGBRGEB
Luminance R G B
A ————————
0
et A
n] 255
Erlghtness |I!!!IIII|\\.,;III|IIII! DL
- — e, [a]
cnntraSI II'I'iIIIMI'IiIiIII I:l-\:r
Hue |III|I|IIMI!IIIIII! '\2 I:l L
Satur‘lt“}n. :I|I:::III\I/'I|:-I:II| S IDD \:
Sharpness: a4 ol

o b

<control> + click inside
the graph to display the
menu

Make adjustments.

Batch adjusts RGB
Adjusts each channel

L raw [REE NRAens | !
|Tone clirve assist | [+ [ [OD ‘
Tone curve adjustment o

R | R |G _Ej [~

255 1 |

S
255
Brightness: m 0 i—
Contrast: s 0 i
Hue: m ‘2 _Di
Saturation: m E E;
Sharpness: [ — 0 0.

o b W

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[]], double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.67).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.67).
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Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones harder

Makes tones softer

About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than [RAW] tool palette, the image color
may be saturated, or the image quality may deteriorate if you adjust too
much. Therefore we recommend for functions other than tone curve
adjustment and automatic adjustment (p.28), that you adjust images
using the same functions available in the [RAW] tool palette.

Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

== Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens] tool palette (p.100) when
reducing noise (p.52) and correcting aberration (p.53) after you have
made any required adjustments with the [RAW] and [RGB] tool palettes.
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Reducing Noise
You can reduce noise that arises in RAW images that have been shot at Display the image in the [100% view] or [200% view]

NR is an abbreviation for “noise reduction”. You can check the noise reduction effect. T

In the [50% view] or [Fit to window] display, it is difficult to check a Glance
the noise reduction effect, so noise reduction is not applied.

Introduction

Select the [NR/Lens] tab sheet on the tool palette.

Adjust an image. Operation
" RAW | RGB | NRjLens }
|NR | Advanced
RAW Operation
e = Drag the sliders right
Low High
Advapced
Chrominance noise @— Imag |t|ng
o and PPinting
TIFF or JPEC
Chrominance noise processing
off Low  High Large Numbers
of Images
? Additional information
Lens aberration correction Tune.. | © The noise reduction function does not work EdirmggiZEG
Noise reduction cannot be applied when [Viewing and saving RAW
Peripheral illumination OFF images] (p.64) is set to [High speed] in the [Preferences] window.
— o Select [High quality] to reduce noise. Reference
To check the noise reduction effect, enlarge the image and
Chromatic aberration OFF display it
Color blur OFF Noise reduction is applied when the image is displayed enlarged in
the [100% view] or the [200% view] in the edit window or the edit Index
. image window. It is not applied in the [50% view] or the [Fit to window]
C“Cl_( the [APp'_y NR]_ button ) ) ) display or any other window as the noise reduction effect is difficult to -
Noise reduction is applied to the image and the image is check.

redisplayed. @ @

If [Luminance noise] has been set, resolution may be reduced

along with reduction of noise.
If [Chrominance noise] has been set, color bleeding may occur

along with reduction of noise.

For a list of tool palette functions, refer to p.100. 50



Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that with DPP ver. 3.2, you can only correct RAW images
which you have taken with the compatible cameras and lenses listed
below. JPEG or TIFF images cannot be corrected.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark Ili EOS-1D Mark Il N
EOS-1Ds Mark || EOS-1D Mark || EOS-1Ds
EOS-1D EOS 5D EOS 40D

EOS 30D EOS DIGITAL REBEL L

XTi/400D DIGITAL

|§| For the images taken with a combination of camera and a lens not in
the above lists or with a compatible lens when the extender is
attached, aberration correction function cannot be used. Since it is
unavailable, the aberration correction function is not shown.

Compatible Lenses

*1

*2

*3

*4

EF 14mm f/2.8L USM

EF 14mm f/2.8L Il USM*! *3
EF 20mm /2.8 USM

EF 24mm f/1.4L USM

EF 28mm /1.8 USM

EF 35mm f/1.4L USM

EF 50mm f/1.2L USM*! *4
EF 50mm f/1.4 USM

EF 85mm f/1.2L USM

EF 85mm f/1.2L Il USM*? **
EF 100mm /2.8 Macro USM
EF 16-35mm f/2.8L USM

EF 16-35mm f/2.8L Il USM*! *3
EF 17-35mm f/2.8L USM

EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-105mm /4L IS USM

EF 28-70mm f/2.8L USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6

EF 28-200mm f/3.5-5.6 USM

EF 28-300mm f/3.5-5.6L IS USM
EF 100-400mm f/4.5-5.6L IS USM
EF-S 60mm /2.8 Macro USM
EF-S 10-22mm f/3.5-4.5 USM
EF-S 17-55mm /2.8 IS USM
EF-S 18-55mm f/3.5-5.6

EF-S 18-55mm f/3.5-5.6 I

EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM
EF-S 18-55mm f/3.5-5.6 1S*°
EF-S 55-250mm f/4-5.6 1S*>

Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses*! and EOS 5D camera,

since it is incompatible.

Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses*? and EOS 5D camera
whose firmware version is 1.0.5 or older, since it is incompatible.
Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses*> and EOS 30D camera,

since it is incompatible.

Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses** and EOS 30D camera
whose firmware version is 1.0.4 or older, since it is incompatible.
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Making Corrections

You can make corrections to one of the four aberrations as below or to
the multiple aberrations at a time.
Peripheral illumination
Distortions
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)

In the tool palette, select the [NR/Lens] tab sheet.

Click the [Tune] button.

[ RAW | RGB | NRpLens }

b |

RAW

Luminance noise -_-—
v [ ]
off Low High

Chrominance noise _—
S | 1
off Low High
TIFF or JPEG
Chrominance noise
off Low High

Lens aberration correction ( Tune... ]

Peripheral illumination OFF
Distortion OFF
Chromatic aberration OFF
Color blur OFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

- The image is corrected and redisplayed.

© Check the results of corrections to peripheral illumination or
distortions in the full view.

©® Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200%.

© You can lessen the degree of correction by moving the slider for
the item you want to correct to the left.
You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

Click the [OK] button
The [Lens aberration correction] window closes and the result of
the corrections is reflected to the image in the edit window and
the image is redisplayed.
The result of the settings of the [Lens aberration correction]
window is also reflected in the tool palette.
In the main window, the [@»] mark is displayed on the image to
indicate the lens aberration corrections (p.97).
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? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

After correcting [Peripheral illumination], some noise may appear in
the periphery of an image.

If this occurs, you can reduce the noise by using luminance and/or
chromatic noise reduction of the noise reduction function (p.52).

The image appears with less resolution after correcting
[Distortion]

After correcting [Distortion], the image may appear with less
resolution.

If this occurs, you can make the image similar to the one before
correction by applying more sharpness with sharpness adjusting
function (p.27).

The colors of the image became weaker after correcting [Color
blur]

After correcting [Color blur], the colors of the image may become
weaker.

If this occurs, you can make the image similar to the one before
correction by making the color deeper with adjusting color tone (p.25)
and/or color saturation (p.82) functions.

The result of [Color blur] correction cannot be detected

[Color blur] correction is effective for correcting blue or red color blur
which sometimes occurs at the edge of the highlighted area of an
image. If conditions do not match, correction cannot be made.

== Correct multiple images at a time

Select multiple images to correct in the main window. Display tool
palette by selecting [Display] menu » [Tool palette]. If you perform
correction procedures (p.54) when tool palette is displayed, you can
apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and paste it to the multiple images (p.33).

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| About [Shooting distance information] slider

When correcting RAW images taken with the EOS-1Ds Mark I,
EOS-1D Mark Il or EOS 40D, it is set automatically according to
the shooting distance information saved to the image.
However, if EF 50mm f/1.4 USM, EF 85mm /1.2L USM or
EF 28-70mm f/2.8L USM is used, it is set automatically to the
right end at infinity position. You can then minutely adjust the
distance by operating the slider while looking at the screen if the
shooting distance is not infinite.
When correcting RAW images taken with other than the EOS-1Ds
Mark Ill, EOS-1D Mark 11l or EOS 40D, it is set automatically to
the right end at infinity position. You can then minutely adjust the
distance by operating the slider while looking at the screen if the
shooting distance is not infinite.

» [Shooting distance information] slider is applied to all the
correction items with check marks.

©® For a list of the [Lens aberration correction] window functions,

refer to p.105.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

In the main window, select an image appended with
Dust Delete Data.

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

ranA ) 172 MG D030.CH2 (3456 x 2304]

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [3,] mark (p.97) is displayed on an image from which dust
spots have been erased.

About dust-erased images

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.35).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

@ The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.58) or the copy stamp function (p.59).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.34).
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.106.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [(O] and
click.
In the main window, select the image you want to I
erase dust spots. —
00 @]
Select the [Tools] menu » [Start Stamp tool]. .

The copy stamp window appears.
Click

When the image has redrawn itself, double-click the
point from where dust is to be erased.

lara 172 4G 00S0.CRZ (3436 » 2304]

» The dust spot within the [O] is erased.
© Click on another part of the image to continue to erase dust spots
in the image.
©® To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.
When the dust spot cannot be erased, [(§)] is displayed.

| St 32 100 Viem i3 parform stamp cewration.

Click the [OK] button to return to the main window.
The [3] mark (p.97) is displayed on an image from which dust
spots have been erased.

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be

erased. "2 Additional information
If the dust spot is dark in color, click the [ ] button, and if . .
o : lick I h letel
the dust spot is light in color, click the [ ] button. Click several times when dust spots are not erased completely

. Where unwanted dust spots are not erased even after performing
When you move the cursor over the image, the dust erasure step 5 once, they may be erased completely when you click several
range appears as [O]. times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be

unable to erase lines of dust. In this case, use the copy stamp
function (p.59).
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.58).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.97) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.75.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.109) is added. The ICC profile
contains information about [Preferences] (p.68) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.

Setting Work Color Space

A different work color space (p.110) from the default settings (p.68) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space setindividually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.68), this
default setting will not be applied and the individually set color space will
remain.

Ay

~

== The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print N o .
together with titles and shooting information, etc. @ /D [EIED (1€ SETngE

Introduction

The settings of each tab sheet in step 3 are memorized when the [Apply] e
Select one image to be printed_ button is clicked (excluding the contents of the [Text] tab sheet). The grgleanr;[(s:eat
settings can be applied to another image when printing.

Select the [File] menu » [Print with detailed setting].

& @ You can set printer profiles (p.68). OpBe?;lc?on
Specify the required settings for printing, and then If CMYK simulation has been set, the image is printed in the set
click the [Print] button. colors (p.68).
Advanced
Switches the settings tab sheet Operation

¥ IMG_0001.CR2

({ Printer | Image = Text Settings ) Ad Ced
: Imag iting
Printer : an d nt| n g
= Processing
Media orientation La‘rge Numbers
o of Images
\_J Portrait
Editing JPEG
Images
CMYK profile:
- Reference
Apply J( Cancel | @ Index

Print preview

The image can be moved by dragging. @ @
Drag the four corners of the image to change the size.
For the shooting information, click [[ & ]] on the [Text] tab sheet

and select the necessary items in the window that is displayed.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].

Specify the required settings for printing, and then
click the [Print] button.

Switches the settings tab sheet

-{ Printer | Image Text Settings

Printer :

Media :
A4

Contact Sheet Prints

Media orientation:

) portrait

C Landscape

Select profile -
Apply ) Cancel

Print preview

@ To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.68).
If CMYK simulation has been set, the image is printed in the set
colors (p.68).
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your compulter.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Specify the required settings for printing, and then
print.

? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

Functions set in DPP that are not applied to printing
Specified output resolution (p.64) and CMYK simulation (p.68) are not
applied.

ALy

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When the color space is set to SRGB or Adobe RGB (p.59, p.68), this
color space is automatically transmitted from DPP to Easy-PhotoPrint
Pro, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

® Printing with a wide color reproduction
When the color space (p.59, p.68) is set to Adobe RGB and the image
is printed with the high-end Canon inkjet printer, the color
reproduction area widens, and green and blue in particular are
reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install the
imagePROGRAF Print Plug-In for Digital Photo Professional on your
computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.64) and CMYK simulation (p.68) are not
applied.

A/

-@> Advantages of printing with the imagePROGRAF Print Plug-In

Printing with faithful colors

When a color space is set (p.59, p.68), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.59, p.68) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences |
Introduction
You can change the various functions of DPP in the Preferences :
window. Check the contents of each window and set. General Settin gs
Also, depending on the item, a detailed explanation may be available, You can specify the folder that opens when DPP is started up, and
so refer to each window. image quality of displayed and saved RAW images. Cg’gg‘r;‘geat
Select the [Digital Photo Professional] menu » Preferences
[Preferences]. i — Basic
i { General settings | View settings Tool palette Color management Opel’atlon
The [Preferences] window appears. Al
fartup rolder
Select the tab sheet, specify the settings, and then Bermeisie
i s Advanced
CIle the [OK] button_ MacOSX/Users/canon/Desktop Opera‘“on
Preferences Save recipe

(%) Display message when adding file

({ General settings | View settings Tool palette Color management ) - Add to file auomatically Ad\%ﬁ ed

Startup folder Viewing and sa\liﬂﬂim_aggs . Imag |t|ng
| . View/save RAW images at high guality an d ntl n g

G High guality (recommended)  Mgiré is reduced and the NR tool palette can be used
| View images at high speed (moiré reduction off}
C High speed

) Specified folder

(%) Last displayed folder ‘

MacOSX/Users/canon/Desktop

Processing

JPEG image guality

Saverecipe | Remove black noise and mosquite noise Large Numbers
#) Display message when adding file Of Im ag es
) Add to file auromartically Default value of output reselution

350 dpi{l-60000]
Viewing and saving RAW images | pit )

. % View/save RAW images at high quality e S
® High quality (recommended)  Maoiré is reduced and the NR tool palette can be used At EOS Utility startup Ed iti ng ‘J PEG

" High spead

| View images at high speed (moiré reduction off) | _! Edit image window enabled at EOS Utility startup Imag es

JPEG image guality

Cancel ) (o)

1 Remove block noise and mosquito noise

Reference
Default value of output resolution
350 dpi(1-60000)
At EQS Utility startup
| Edit image window enabled at EOS Utility startup d
Index
Cancel ‘ E—ﬁl(i% _
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.52) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.52)
to reduce the luminance noise and chrominance noise.
You can check the effects of the false color reduction processing and
noise reduction function in the edit window or the edit image window
in the [100% view] or [200% view] enlargement display.
In the [50% view] or [Fit to window] display of the edit window, edit
image window, or any other window, the effects of the false color
reduction processing and noise reduction function are difficult to
check, so they are not applied.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]

If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied.
As the [View images at high speed (moiré reduction off)] setting is the
same as [High quality] other than for display of the image, the image
undergoes false color reduction processing when it is saved and the
noise reduction function is also available.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window in
the [100% view] or [200% view] enlargement display, and the time it
takes to save a RAW image is less than in [High quality].
You cannot use the noise reduction function (p.52).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

? What is the difference between the [High quality] and [High
speed] displays?

The display image quality of [High quality] and [High speed] is the same
except when the image is displayed in the [100% view] or [200% view]
enlargement display in the edit window or the edit image window.

© JPEG image quality

You can improve the quality of a JPEG image by reducing their noise
characteristic that occurs when RAW images are converted to JPEG
images and saved (p.34, p.74).

This setting is also effective for JPEG images that have been saved with
a different name.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.34, p.74).
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Introduction
View Settings Sort order in main window
_ _ _ _ You can set the order of images which have been rearranged in the
You can specify settings relating to the display. main window to be maintained or not maintained (p.18). e
If you checkmark the checkbox, the order of the rearranged images is a Glance
f Preferences ) maintained even if you quit DPP or select another folder in the folder
_ area.
[ General settings | View settings | Tool palette | Color management - If you remove the check mark, the order of the rearranged images is not Basic
i maintained and reverts to the previous order when you quit DPP or R
T 64 Pixelsis-256) select another folder in the folder area.
Locking selected image Advanced
™ Images opened in Edit window remain selected in main window Operation
Magnification in Edit window ng h I Ig ht/Shad ow warn | ng
f*) Fit to window ) 50% ) 100% O 200% . . .
Highlighted/shaded areas that exceed the set range can be displayed AdvERced
Magnification when the Edit/Edit image window is double-clicked on the image as Warning indicators (p47) Imag\ajiting
() s0% ® 100% ) 200% and nting
RAW and JPEG

E{ Display only CR2 images for CR2 and JPEG files of the same name Processi ng
Sort order in main window Large Numbers
_| Retain sort order | of |mages
Highlight/shadow warning
il
Highlight 192 aez-255 .
e 0 064 e Editing JPEG
Images
Quick check tool display , W
@ s0% ) 100% (muoiré reduction off)
Cancel ) —0ok—) Reference
Index
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Tool Palette

You can specify settings for the tool palette.

Preferences

Default settings of RGB Tone curve mode

Tone curve mode Interpolation method
Y RGERGE %) Curve
: Luminance R G B '_\_, Straight

Histogram display
) Before adjustment
#) After adjustment

Tool palette display in Edit Image Window
®) Dacking display

_ Floating display

Modified Picture Style settings
E Retain settings of each Picture Style

Tool palette display mode
! Same for Main window and Edit window

+ GCeneral settings View settings | Tool palette | Color management -

Cancel \ (

0K

Default settings of RGB Tone curve mode

When the setting is changed, the setting will be applied when DPP is
restarted.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast]
and [Sharpness] settings will be changed or retained, when you change
the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

+ General settings View settings Tool palette | Color management }

Default settings of Work color space
) sRGB

) Adobe RGB

) Wide Gamut RGB

" Apple RGB

") ColorMatch RGB

CMM settings for print
For display :
) sRGB
) Monitor prafile
ENG/Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB49E4.icc
Printing profile:
" None I3 }

Rendering intents:

CMYK simulation profile: Rendering intents: | |

None )

A\

Cancel f 0K "

Rendering intents when using Easy-PhotoPrint
) Perceptual

(®) Relative Colorimetric

Default settings of Work color space

You can select from five types of color space (p.110) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.34,
p.74) or printed (p.35, p.38, p.40, p.60 to p.63).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the edit
window (p.98) and the edit image window (p.102).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.59).

® Display setting (color setting of the monitor)

Where a profile (p.109) is attached to the monitor you are using, you can

display an image in more faithful colors by setting the profile.
Checkmark the [Monitor profile], click the [Browse] button and in the
dialog box that appears, select a profile for your monitor.

ALy

5@5 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.109) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.40, p.60, p.61) except for linked printing (p.35, p.38, p.62,
p.63).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

=@> Automatic settings with linked printing

If you are printing with a Canon inkjet printer (p.35, p.38, p.62, p.63), a
profile is set automatically even when the [Printing profile] setting is not
performed. This allows you to print easily with faithful colors.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.110) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.96, p.98,
p.102) in the bottom of the main window, edit window and edit image
window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.110) for printing
with Easy-PhotoPrint (p.35, p.38).

The rendering intent is ordinarily set to [Relative Colorimetric].

> When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images

Introduction

For users shooting a large amount of RAW images, the convenient

function of batch processing large amounts of RAW images is explained
Contents at

here. a Glance
Utilizing Adjustment Contents (Recipe)................... 71 R
Saving Recipes as a File.......ccccoovevveiiiiiiiiiii e, 72 Operation
Loading and Pasting ReCIPeS..........cccevvvvvviiiieeeeeeennnns 72
Copying a Recipe and Applying to Another Image..... 72 Advanced
Batch Apply White Balance to Images (Personal White i
BalanCe) .......ouuuveiiiiiii i 73 Adionoed
Registering Personal White Balance.......................... 73 Ir;r?(?le; Eﬁltiit:]rgg
Applying Personal White Balance .............ccccccceeeee. /73 ——
Batch Save as JPEG or TIFF Images (Batch L;;ngrs
PrOCESSING)...uuiiiiieiiie e 74 of Iméges
Batch Transfer Images to Image Editing Software.. 75
Batch Change the File Name of Images.................. 76 Edifﬂ{,‘ggﬂ;EG
Changing the File Name of Images in the Order in the
MaiN WINAOW .......coveiiiiiiiiiiiiiiiiieeeee e eeeeeee e 76
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from large numbers of images shot with the same shooting environment
and batch applying the adjustment results to a large number of images.

000 ¥ IMG_0015.CR2
e RAW RGE | MRMens r—

| Brightness adjustment =3

|Whjle balance adjustment - |
[#] s s et it

Shot settings B Tune.. )

|Picture Style ey |

Standard |¢]I” Browse... )

-10.0 -8.0 -6.0 -4.0 -2.0 O 20 4.0
Contrast: "‘“‘""‘9—“—“‘
(o) T i G

| Linear

Color tone: "—-—-"9'-—“““
o e e
Color saturation: .-—-—-—-9—-—-—-—-—
{0 I e

Sharpness: —-9-—-—-—-—-—-——-—-\
1) ! R

RAW image data

- !

I \N
Lvrd

Contents adjusted using the tool
palette can be handled

individually as a recicpe file
(extension “.vrd").

|§| The adjustment contents of JPEG images can be saved as a recipe
file (extension “.vrd”) and loaded and applied to another image in
the same way as with RAW images (p.78, p.92).

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB] and [NR/Lens]). For this reason, other editing content such as
trimming or dust-erasure (copy stamp) is not included in the recipe
data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Introduction

Saving Recipes as a File
Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu P [Save recipe in file].
The [Save] dialog box appears.

Select the destination folder, enter a file name, and
then click the [Save] button.

? Check the contents of a recipe file by pasting to an image

When you do not know the contents of a recipe file, paste it to an image
and check the settings in the tool palette. When only a few settings are
adjusted, we recommend you use a file name that describes the
contents or that you separately record the adjustments as text
information.

Loading and Pasting Recipes

Select the image to which arecipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select arecipe and click the [Open] button.
The recipe is applied to the image.

Select the image from which arecipe is to be copied
and then select the [Edit] menu P [Copy recipe to
clipboard].

The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe to
selected image].

The recipe is applied to the image.
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Registering Personal White Balance
Adjust the white balance (p.23, p.24, p.48).

In the [RAW] tool palette, click the [Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

enn [# Register personal white balance

Register current setting in personal white balance

Current setting: Click white balance

[ Custom 1 f :n

Applying Personal White Balance

In the main window, select the image to which white
balance is to be applied.

Click the [Tools] button on the toolbar.
The tool palette appears.

Click the personal white balance number button that
Is to be applied.

| RAW RGE  NRiLens ———|
‘Eﬂghmess adjustment =3
|||m||||||||||| 0.00
‘While balance adjustment = i‘
s’ MRegister..._
{ Shot settings | $] Tune.. )
‘Picturtitm [ B ;‘
{ Standard f $_] { Browse.. )

v ~a

A

h--il]_l] -80 -60 ~40 =20 0O 2.0 4.0

Caontrast:
{U] 1 1 1 1 v 1 1 1 1
[ Linear
Color tone: =
1 1 1 1 v 1 1 1 1

{(1)]
Color saturation:

{u] ] 1 1 1 (? 1 1 1 I
Sharpness:
{]_] —I—G 1 1 ] I 1 1 1 1 1

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing) .
You can batch convert and save edited RAW images to highly versatile In the processing dialog box, click the [Terminate]
JPEG or TIFF images. button.
The images are saved as separate images, so the RAW images remain
Contents at
unaffected. a Glance
In the main window, select multiple images to be
converted. Basic
Operation
Click the [Batch process] button on the toolbar (p.96).
The [Batch settings] window appears.
] ) ] . Advanced
Specify the required settings, and then click the Operation
[Execute] button.
Batch settings Advanced
Save folder it
.0 S == "2 [Save] cannot be performed ";‘nag%ﬁgt'i‘g”gg
2 . File format :
G 0008 cxz o= = In the [Batch settings] window, you cannot perform [Save] or [Save As]
e 0007 e Image ey 9 u (p.33, p.91) to edited RAW images. Procedsing
IMG_0008.CR2 Output setting Larg bers
::E:gggzg;i Qutput resolution | 330-dpi ¥ Embed ICC profile Of m ges
Rac00n2. 02 e e ” =@ Skillful batch saving
e 015 o e © While saving is being performed, you can continue working in Editing JPEG
- - . Images
File Name another WIndOW
e Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
N o main window or the edit window during the saving process. Reference
el e L To convert all images and save, do not select an image in the
Ex. DPP_000L,IPG, DPP_O002.IPG maln W|ndOW
S A e If you do not perform step 1 and perform step 2 with no image e
(_sromse.) selected in the main window, all the images displayed in the main
(C convertRaw mages ooy ) (_Concel | (B window will be converted and saved. [
The processing dialog box appears and saving begins.
When all the images are saved, the [Terminate] button appears in ﬁ' If you have selected [New file name] in [File Name], [Sequence @ @
the processing dialog box. number] has to be set.
By saving as explained on this page, a trimmed image (p.31,
p.86) or dust-erased image (p.56 to p.59, p.88 to p.91) actually

becomes a trimmed image or dust-erased image.

For a list of [Batch settings] window functions, refer to p.107. 74



Batch Transfer Images to Image Editing Software _
Introduction
You can transfer multiple images to image editing software. The Select Photoshop CS.
software used here as an example is Adobe Photoshop CS. In the [Open] dialog box, select Photoshop CS, and click the
. . . . [Open] button. Contents at
In the main window, select multiple images to be The [Open] dialog box closes and [Image transfer settings] in the a Glance
transferred. [Batch settings] window is set to Photoshop CS.
Click the [Batch process] button on the toolbar (p.96). Checkmark [Open image using software]. Basic
The [Batch settings] window appears. e Operation
Perform settings required for transferring (e.qg. file (&Josen image using software
fOI‘mat). Adobe Photoshop C8 Browse... Advanc_:ed
i { Cancel 3 ( Execute ) Operatlon
Click the [Browse] button.
e Click the [E>_<eCl_Jte] button. _ Advanced
sl S S P » The processing dialog box appears and batch transfer begins. Image Editing
ML Eice Fie formar _ »When the first image has been transferred, Photoshop CS starts SOe] G|
iy g e £ up and transferred images are displayed in transferred order.
IMG_0007.CR2 i i e Procedlsin g
R0 0005002 Qupstzsting - Larg bers
IMC_0010.CR2 Ouput resalution 350 dpi [ Embed ICC profile of Im ges
IMG_D011.CRZ I?esiz? setting
015000 BT T R Editing JPEG
¥ Lock aspe Images
File Name
: C.urrenl file name
(*) New file name Reference
EX,I::‘PR DPP_OOO1JPG, IUJZI’D_;DDZJPG Renn e
Image [ransferrse((mgs
?-ﬂpen image using software IndeX

The [Open] dialog box appears.
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Batch Change the File Name of Images |
Introduction
In the main window, select multiple images of which Changing the File Name of Images in the Order in the Main Window
he file nam r han . : : o
the file names are to be changed When you change the order of the images in the main window (p.18),
Select the [Tools] menu » [Start Rename tool]. you can change in one operation the names of the files for the images, Cg’gg‘r;‘geat
The rename window appears. in the order they were rearranged.
Specify the required settings and click the [Execute] Change the order of the images in the main window Basic
button. (p.18). Operation
MacOSX/Users /canon/Pictures [Photo /xxxx_xx_xx . . . . .
i In the main window, select multiple images of which
File Name . Extension . Advan Ced
DPP 2 Shooting Date/Time 3 Sequence number ﬂ Do not change 3 the flle nam es are to be Cha‘nged' Operatlon
e S Select the [Tools] menu » [Start Rename tool].
@ it to main window UU. 1 ) _ ave sequence number
:Ifi\e Name . g : : : Advanced
) shooting Date/Time Shooting Date/Time . - - Image Edltlng
G a oo - Select [Fit to main window]. S BT
__ Copy & Rename " MM-DD-YY k| - e
MacSX Users/canon [Desktop # Insert underbar :IL’ MacOSx
Proceflsing
Modified Fil Modified File N Larg bers
File Name of Im#ges
Pooimz ) R
MG.0003.70 B . o0-13-05. 000670 Basi€ Settings Ed'mggi';’EG
MC.0005.C Dre_05-15-06.0008 012 ' Sont
II:IG,ODOS.JPG . E:PP,DB—I}—US,UDLO.JPG . . i B Fit tD main windﬂw
{_Cancel _ " File Name Reference
Processing begins and the file names are changed. v SEBOHNG DatefTime
Specify the required settings (p.108). Index
To copy an image, checkmark [Copy & Rename].
? Changes cannot be made when the file name is duplicated Click the [Execute] button.
If a file name in red text has appeared in [Modified File Name], the file The file names are changed and the order in the main window is
name has been duplicated. Changes cannot be made if even one file maintained.
name has been duplicated. Change the settings so that duplication does
not occur.

|§| For a list of the rename window functions, refer to p.108. 26



5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. Cgrgstle;ntgeat
Editing JPEG and TIFF Images...........ccceevvvieeeeeeenn. 78 R
About the RGB Tool Palette ..........ooveeveeveieieieeeeeeennn, 78 Operation
Automatically Adjusting Brightness and Color (Tone
CUIVE ASSISE) covviiiiiiee e 79 AN
Adjusting Brightness and Contrast...............c.cc.cc....... 80 ok
Adjusting Color Tone Using Click White Balance....... 81
Adjusting Hue, Saturation and Sharpness.................. 82 |m':g\<lea£gﬁidng
Tone Curve AdjuStMmENt.............eevveiiiiiiiiiieeeeeeeeeeeeenn, g3 (2ndEunting
Adjusting Dynamic Range ...........cccceeveveeeeeeeeeeenenne. 84 [ processing |
Reducing NOISE ...cc..vuiiiiiiiiiiie e 85 Laégfe.r'#‘égé’ﬁ's
TrimMmMING an IMage......cccooveeeeiiiiiieeieeeeee e 86
Performing Automatic Dust Erasure Processing ..... 88 Edifﬂrﬁfs’EG
Automatic Dust Erasure Processing in the Main
WINAOW .. 89
Manually Erasing Dust (Repair Function)................ 90 Reference
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCHION). .. 91 Index
Saving Editing ResultS........cccovvviiiiiiiiiiiiiceen 91
Saving Editing Content to an Image.............ccccevvvenn. 91
Saving as a Separate Image .........ceceeiiieeerieeeiinnnnnnn. 92 @ @
Applying Editing Contents to Another Image........... 92
PHNTING ..o 92 @
Re-Editing an Image.........cccccoeeeeviiiiiii e 92
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any nhumber of
times.

a8 & * IMG_D015.JPC
" RAW | RGB | NRiLens |
B g =)
Tone curve adjustment |
R r | c]& |
>

255

Tone curve assist

¢

l‘

)

s

] < I \N
. - [vrd |
Brightness: O Y e —
ARERRERR T (IRRERETRT] -
e

Contents adjusted using the tool
palette can be handled
individually as a recicpe file
(extension “.vrd”) (p.71, p.92).

Hue:
Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.91), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.71, p.92).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than [RAW] tool palette, the image color
may be saturated, or the image quality may deteriorate if you adjust too
much. Therefore, take care not to adjust your images to an excessive
degree.

You can adjust RAW images with the functions in the [RGB] tool palette.
However, for functions other than tone curve adjustment (p.83) and
automatic adjustment (p.79), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.109). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

—————— RAW | RGB | NRiLens |
\Tf’"'-’ Rl Esaiat | [ | [+ Ji7s [——Reverts the tone curve
Tone curve adjustment [ | to the original Settings
RCE R | | & A
o « [ [+ | 7l
255 - High
Standard
D : T
0 255
Eﬂghtﬂess trrrirerrYreernrene DE
Contrast: "__'Q___‘ ols
Hue et |‘r?r‘! DE
Saturation: ol 100]]
Sharpness: @—igi 0 ?

The tone curve changes as adjusted.

@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

® If you click the [] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.82).
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Introduction
- : . Brightness: Move the slider to the right to make an image
Adjusting Brightness and Contrast g . J . g
brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance
T . R HRAons contrast of an image stronger and to the left to
e riirve 2ot make contrast weaker.
| =D Basic
Tone curve adjustment -y | Operation
. B
255 r l
Advanced
Operation
Advanced
Image Editing
and Printing
Processing
b _ Large Numbers
j of Images
: ~—|  Drag the sliders left or
s — right Editingep] PEG
Brightness: 0 i—l | ()
Contrast: 0 Enter numerical values
Hue TLRRL P rEYre et LE‘I Dz
Salul'iltiﬂ-n: (AR R AR RN R lEJ lDD z Reference
Sharpness: e—'el 0 ?
Index

|§| The adjustment range is —100 to +100 (in 1-stop increments when

entering a value). 80
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Introduction
Adjusting Color Tone Using Click White Balance Click on a point that is to be the standard for white.
ana # ital Photo Professional - [ MacOSX/Users [canon Pictures Photo) xxxx_xx. _xx/IMG_DDL0JPG |
You can adjust white balance using a selected part of an image as the &
standard for white to make the image appear natural. Using click white Cg’gf’;r;‘geat
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.
] Basic
Click the [[~]] button. Operation
p—er——— RAW | RGB | NRilLens
‘Tnne curve assist [ I HE_'_ HED| Advanced
Tone curve adjustment L-i_-, [ Operation
Rlcle]
255 Advanced
Image Editing
and Printing
i 5471, 216, 22250000 T
_ N ) Processing
The coordinates of the cursor position and the RGB values (8-bit Large Numbers
conversion) of Images
'. _ =» The color of the image is adjusted with the point you selected as -
| i L the standard for white. Ed';‘r"ge':EG
i T © If you click on another point in the image, the white balance is
: adjusted again.
0 215 To finish click white balance, click the [] button again. Reference
Erighm!ss trrrirerrfrerrnrnnn Diﬂ
cuntraSl: trnrrrereYrerrerrent Dg
i e v e 3 I B '? When there are no white areas in your image Index
pauron: T AR LEJ Lol ; When there are no white areas in your image, you can adjust the white k )
i e el o balance by clicking on a grey point of the image in step 2. This has the

same adjustment result as selecting a white point. @ @

The image is adjusted based on the average value of 5 x 5 pixel

range from the clicked point. @
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any

adjustments (p.67). 81



Introduction
- : : Hue: Move the slider to the right to make color tones
Adjusting Hue, Saturation and Sharpness g
more yellow, and to the left to make color tones
You can adjust hue (tone) and saturation and make the overall redder.
atmosphere of an image harder or softer - - : Contents at
: Saturation: Move the slider to the right to make the color a Glance
deeper, and to the left to make the color weaker.
— [ RAW [RGB NRfens | Sharpness: Move the slider to the right to make an image .
‘Tane curve assist (@ ] I@ﬂ harder, and to the left to make an image softer. OpBe?thfon
Tone curve adjustment E=] ||
e r [ c | & |
2551 ' Advanced
Operation
Advanced
Image Editing
and Printing
Processing
- Large Numbers
of Images
0 2 | EditrirrSPEG
0 255 | es

Enghtﬂess (AR AR R R RN R D‘:r'
Contrast: "——'@——-‘ n:
trnrrrerryrrrrrneent L

Hue: A o) ol Reference
Saturation: — (b 100 3—} Enter numerical values

Sharpness: e [ | Gl |
p frrrrerreeninn |~_b-J D -:—

Index

Drag the sliders left or right ‘2  Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]

or [200% view]. If the view is set to [Fit to window] (full view), the @ @

sharpness will seem unnatural.

ﬁl The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, @
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
82



] Introduction
Tone Curve Adjustment Make adjustments.
You can adjust the brightness, contrast and color of a specific area by Batch adJUStS.RGB
: Adjusts each channel Contents at
changing the tone curve (p.109).
: . a Glance
e RAW || RGB | NR/Lens .
Select the tone curve mode and interpolation [Tone chrve assist EEE)
method . Tone curve adjustment = Basic
— —_—— Operation
—— RAW |FSRGE™S NRAens | : - Urlc]=] [i'
|T0ne curve assist O 2o ‘ 255
Tone curve adjustment b Advan(_;ed
— —_— Operation
@] « o]+ ] 7|
255 [ l
) _ Advanced
Click to add a [[] (point) Image Editing
Adjust by dragging [[] and Printing
v Curve
Straight (L Processing
<control> + click inside W Large Numbers
v RGBRGB the graph to display the of Images
Luminance R G B menu 0. % g
255 -
Erlghtn!ss' .Illllllll\l/llllllllll D i Edlit’!’SezEG
Cuntras‘ II'I"III;\({III'I'III D :
0] : e -
e | —— e, -
0 255 Hue: T o0 S
Erightness: : ™ 0 :‘ SENELTEG Y E 140 -i Reference
Contrast: S — S — 18 il v C (BIC] 6
Hue: p——— D) D g8 The horizontal axis shows the input level and the vertical axis
Saturation: 5] 100 (% shows the output level. Index
Sharpness: - KR8 The maximum number of [[]] is 8. ——

To delete a [[]], double-click on the [[]].

@ The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any @,
adjustments (p.67). 7
The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.67).



Introduction
Adj usti ng Dynamic Range @ The setting range of shadow points is 0 to 247 (in 1-stop
Dynamic range (width of gradation expression) from dark points to bright increments when entering a value).
ynamicra _ge( ot gracation expressio ) from dark points to brig The setting range of highlight points is 8 to 255 (in 1-stop Contents at
points in an image can be adjusted. : :
increments when entering a value). a Glance
The histogram display changes according to adjustment. You can
Move downwards also fix the histogram display to the display before any .
Output highlight points adjustments (p.67). Basic
Operation
RAW | RGB| | MNRLens |
‘Tane curve assist ﬂ'@J@”
Tone curve adjustment [ 4— Reverts the Advanced
—_ Operation
o e [ c g | 2 image to the
Output —— 259 orlg_lnal
highlight point settings Advanced
numerical Image Editing
value and Printing
Processing
Move to the — Move to the Large Numbers
right left of Images
Input shadow . Input highlight
points points "
; | Editingpl PEG
: I es
Outputshadow —— @ J
pointnumerical 0 255+ Input highlight
Value Enghme s rrrrriregprrrrrrnirnnn D 1‘: pOint numerical Reference
Cont :} e — = | value
|npUt ShadOW_ Sl [RRERRRER (N (R RERNTRY] D:
pOIntnumerlcaI Hue: e rreeyrrernrnenn |3| D \iﬂ
value Saturation: Ses———rol 100][-] Index
Sharpness: _-Lg-} o ?
Move upwards
Output shadow points @ @
The horizontal axis shows the input level and the vertical axis shows
the output level. @
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/Lens] tab sheet on the tool palette.

Adjust an image.

" RAW | RGB | NRjlens }

B |

RAW
Luminance noise =
off Low High
Chrominance noise
oft Low High
TIFF or JPEG . .
Chrominance noise = Drag the slider rlght
Low High

Lens aberration correction

T—

Click the [Apply NR] button.
Noise reduction is applied to the image and the image is
redisplayed.

Display the image in the [100% view] or [200% view]
enlargement display.
You can check the noise reduction effect.

In the [50% view] or [Fit to window] display, it is difficult to check
the noise reduction effect, so noise reduction is not applied.

? To check the noise reduction effect, enlarge the image and
display it

Noise reduction is applied when the image is displayed enlarged in the
[100% view] or the [200% view] in the edit window or the edit image
window. It is not applied in the [50% view] or the [Fit to window] display
or any other window as the noise reduction effect is difficult to check.

|§| If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
For a list of tool palette functions, refer to p.100.
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information.

Select the image to be trimmed.

Select the [Tools] menu » [Start Trimming tool].
The trimming window appears.

When the image has redrawn itself, select a ratio and

drag the trimming range.

B0 # 171 IMG_DO0LJPG [3456 x 2304]

Full screen

(e (== )—— Cancel

Select a
T - trimming
"""" § IT—-E ratio

e Drag the
ﬁ trimming
' range

(O 50415 3026, 1EN0 ) = (1969 x 132611 190

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can freely trim an image.
[Custom]: You can trim an image at the specified ratio.

1' Click the [OK] button to return to the main window.
=» The trimming range frame is displayed in the trimmed image
(p.97).
=»When the trimmed image is displayed in the edit window or the
edit image window, it is displayed as a trimmed image.

)
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.92).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.97).

* Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.92).

Images that have aspect ratio set display as trimmed images
When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information. However, since the
image is not actually trimmed, you can change the trimming range or
revert to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.104).

The image is displayed in its trimmed condition.

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.104.
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Performing Automatic Dust Erasure Processing S
The Dust Delete Data that is appended to images shot with the camera About dust-erased images
that can attach this data, can be used to automatically erase dust spots. =
The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time Contents at
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu » [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the Basic
The copy stamp window appears. copy stamp window or performing the “Re-Editing an Image” Operation
. . ) procedure (p.92).
When the image has redrawn itself, click the [Apply Check dust erasure in the copy stamp window
Dust Delete Data] button. Check dust erasure in the copy stamp window. Images before dust gd‘é?gt‘i’gﬁ
s R erasure are displayed in other windows and you will be unable to g
check them.
Printing dust-erased images Advanced
You can print as a dust-erased image by printing it in DPP. 'Qnaggﬁgt'};]"gg
@ The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the Processing
camera, if there is no dust to remove by DPP from the image, the Large Numbers
[Apply Dust Delete Data] button will be disabled. of Images

[ Caneni ] -

L e 1008 e 14 i Lt s i)

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [ 2,1 mark (p.97) is displayed on an image from which dust
spots have been erased.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.90) or the copy stamp function (p.91).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.92).
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.106.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editi PEG
| es

Reference

Index

89



Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [O] and
click.

o = 17 BAC_DGS0 PG (1438 = 2304]

In the main window, select the image you want to
erase dust spots.

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

- .
When the image has redrawn itself, double-click the O e Click

point from where dust is to be erased. o

-Tals) #) 112 MG 00509 [3456 « 2304]

Double- "y .
click =» The dust spot within the [O] is erased.

© Click on another part of the image to continue to erase dust spots
in the image.

©® To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

@ When the dust spot cannot be erased, [()] is displayed.

L 100 b i b .

The display changes to 100% view. Click the [OK] button to return to the main window.

The display position can be changed by dragging. The [ %] mark (p.97) is displayed on an image from which dust

) spots have been erased.
Click the button that matches the dust spots to be P

erased. "2 Additional information
If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button. Click several times when dust spots are not erased completely

Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.91).

When you move the cursor over the image, the dust erasure
range appears as [O].

)
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Saving Editing Results |
Introduction
Erasing Unwanted Parts of an Image (Copy Stamp Function) Saving Editing Content to an Image
You can correct an image by pasting a section copied from another part All the contents (recipe) adjusted with the tool palette (p.78 to p.85) as
of the image to an unwanted part of the image. well as the trimmed range (p.86) and dust-erasure (p.88 to p.91) Contents at
. . . a Glance
information can be saved to a JPEG or TIFF image, or to a separate
Follow steps 1to 3in “Manually Erasing Dust (Repair JPEG or TIFF image.
Function)” (p.90). _ : _ Basic
_ _ _ Select the [File] menu » desired item. Operation
Specify the section to be copied.
Click on the section that is to be the copy source while holding TRl e
down the <option> ke LUl ol Advanced
p Y. Open in Edit window (enlarged)... Operation
To change the section that is to be the copy source, perform the
operation above again. e wm&‘;"; i
To fix the position of the copy source, checkmark [Fix Copy | Advalgg_?_d
iti Save E mage Iting
Source position]. - oas | and Printing
Correct the image Add thumbnail to image and save {r3fT
: o . C d save... #®D :
Click or drag on the section you want to correct on the image. [+] B:t?:;;:essze %R L;roec&rsgggrs
in the window indicates the copy source and [Q] indicates the 0% Image
copy destination Create new folder... {+3EN ages
The copied image is pasted in the position to which it was il e
dragaed print..._ , _ e Editinge) PEG
ggea. Print with detailed setting... 3D | es
For [Pen type], you can select from [Brush] (the pasted image’s Contact Sheet Prints... ~38P
borders simulate a brush) and [Pencil] (the pasted image’s Plug-in printing g
borders are sharp). Delete ®a
: . . Info... 32| Reference
Click the [OK] button to return to the main window. _ _
The [ 2] mark (p.97) is displayed on a corrected image. Your adjustments are saved to the image.
Index
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.78 to p.85)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.86) or dust-erased image (p.88 to
p.91) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.34)

Batch save as JPEG or TIFF images (batch processing) (p.74)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image =

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.33)

Utilizing adjustment contents (recipe) (p.71)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.35)

Printing with shooting information (p.60)

Printing a thumbnail list (contact sheet printing) (p.61)

Printing RAW images on a high-end Canon printer (p.62)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.78 to p.85), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.86) or dust-erased image (p.88 to
p.91) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.91) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

Rotate Left #L
Rotate Right 3R
Add check markl HF1
Add check markz HF2
Add check mark3 HF3
Clear check mark HF4
st

Waork color space >
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings 32
Revert to shot settings ~37

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.

el An Index is provided at the end of the chapter for you to easily find
o information you are looking for.
Troubleshooting........ccuuiiiiiiiiici e, 94
Deleting the Software (Uninstalling) ........................ 95
List of Main Window Functions.............ccccceeevvveen. 96
Image Frame Information in the Main Window and Edit
IMage WINAOW..........cooeeiiiiiiiiiiiiiieee e 97
List of Edit Window Functions ...............cccoeeeevvveenn. 98
List of Tool Palette Functions ...............c.ccceeeeeeeeeenn. 99
List of Quick Check Window Functions.................. 101
List of Edit Image Window Functions .................... 102
List of Convert/Save One Image Window Functions 103
List of Trimming Window Functions....................... 104
List of Lens Aberration Correction Window Functions 105
List of Copy Stamp Window Functions.................. 106
List of Convert/Save Multiple Images Window (Batch
Processing) FUNCLIONS ........c.ccoviiiiiiieccceeeeei 107
List of Rename Window Functions......................... 108
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100 L= 111
About This Instruction Manual ...............ccccceeeee. 115
Trademark Acknowledgments..............cceevvvvnnnnnn. 115
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements does not meet. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly (p.3).

When a dust-erased image (p.56 to p.59, p.88 to p.91) is displayed in
a window other than the copy stamp window, it is displayed as it was
before dust erasure was performed. Check dust-erased images in the
copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.99).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.9, p.21, p.96, p.101, p.102),
trimming (p.31, p.86), dust erasure (copy stamp) (p.56 to p.59, p.88 to
p.91) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.99).

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.59,
p.68) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to SRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.68) and a profile for a printer is
set up correctly (p.68), the color of a printed photograph and the color
of an image on screen can be more closely matched. Printing with a
Canon printer (p.35, p.38, p.62, p.63) automatically sets up printer
profiles, so you only need to set the color of the monitor to bring the
colors closer together.

When printing with Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.39).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.41).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with the EOS 10D and
EOS DIGITAL REBEL/300D DIGITAL may not display image
information (p.9, p.20).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

806 + Applications )
[« » 585 m|[ 3~ Q

D newwork i @ {;_é

| 24 Macos_10.4 ‘ ‘ e — > %’

| ‘:’ Mail OmniGraffle OmniOutliner

| i pata_01

| _—

m Desktop &@ @ @

| ﬁfr canon ‘ Preview QuickTime Player Safari

| /== Applications

E Documents
| % Movies
| & Music 7

V. 4

Sherlock Stickies System Preferences

| Pictures i -
TextEdit Utilities Canon Utilities

£ ; 37 items, 217.24 GE available 7

Drag the folder for the software to be uninstalled to
“4= the Trash.

> Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

® You cannot retrieve data that you have emptied into the Trash and

deleted, so be particularly careful when deleting data.
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List of Main Window Functions ©.9

Cancels selection of all images

Selects all images Folder path

Shows/hides the tool palette (p.99) Check marézr(&\l/g check marks (p.17)
Shows/hides the folder area Image rotation (90 degree units)

Switches to the edit image

window (p.102) | ‘

Digita| Photo Prjofessiong|l File [dit View Bookmark Adjustment Tpols Window Help
Digital Photo Professional - [ MacOSX /Users/canon/Pictures/Photo /xxxx_xx |xx ]

Batch conversion/saving
(p.74, p.75)

Toolbar*!

» A Applications
[ Temporary Items
¥ |+ Users
v @ canon
» [@H Desktop
[ Travel
» |5 Documents
» & Library ® ® . ® L s
‘T ::\;::s " IMG_0001.CR2 * IMG_0002.CR2 Rid 7|\‘C_‘7EL'E CR2
¥ [ _Eiﬂures =
¥ [# photo "
» (@ Pu"t}'lricmm_w_xx
P [ Sites
> L'_,; Shared
IMGLOD0ECRZ _ IMG_0007.CR2 IMGI0008.CRE. 14620008 CR2 IMG_0010.CR2
Folder area*? ————— Eg
i Mi
[c] ol d [c] ®
\‘.‘CL}.Z.CR? 3 IMG_0013.CR2 ¥s IMG_0015.CR2
Display mode**
|nf0rmatI0n d|Sp|ay*3 —%2153‘ 1063 ) : 152, 152, 148 = High quality Recipe data: Yes Number of images: 15 Number of selected images: 1 Fo Y — - E— CMYK S|mu|at|0n d|Sp|ay
| | B | | (p.68)
Recipe attachment status (p.71) Number of images Number of selected images
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *3 Displays the coordinates of the cursor position and the RGB values (8-
*2 The images inside the folders selected here are displayed in a bit conversion) when click white balance was performed with the tool

thumbnail list on the right. palette.
*4 The item selected in [Viewing and saving RAW images] (p.64) of the
[Preferences] window is displayed.

)
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Image Frame Information in the Main Window and Edit Image Window ®.9.p.29)

Information displayed when [Large thumbnail] (p.9) is selected

Digital Photo Professional - [ MacOSX /Users/canon /R

CRCERC

Tools Salect all Clear all

¥ = Mac0sX
E:hfgk mla7r;< b [ Applications Copy stamp mark
pam P [¥ Temporary Items (p951€; to p.59, p.88 to
¥ |k Users P.
v & canon .
» @8 Desktop Lens a_berratlon
[ Travel correction mark (p.54)
p | Documents
» (@ Library Trimming range*®
Brightness | Movies (p-31, p.86)
adjustmentvalue*! L& Music
(p.22) Ll e Aperture*3
. : [ rh
White balance icon*! ¥ i kioto
Lo MMM _MK_XX
(p-23) b (& Public
> [ Sites
> [ Shared

*1 Does not display with [Small thumbnail].
*2 Displays in RAW+JPEG images displayed as a single image (p.19).
[RAW] is displayed in RAW images. (In [Small thumbnail] (p.9), [R] is

displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

RAW adjustment mark*1*4
RGB adjustment mark*1*>
Unsaved editing content mark
Shutter speed*3

File name

Image type*?2

*4 Displays in an image edited with the [RAW] tool palette in the edit
window and the edit image window.

*5 Displays in an image edited with the [RGB] tool palette in the edit
window and the edit image window.

*6 When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the image is displayed as
a trimmed image.

)
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List of Edit Window Functions .10, p.21)

Introduction
Path and file name of image Tool palette*! (p.99, p.100)
006 |+ Digital Photo Professional - [ MacOSX /Users/canon/Pictures,/Photo/ xxxx_xx_xx/IMG_0001.CR2 ] D00 [ IMG_0001.CR2 o Contents at
| RaW | RGB  NRiLens a Glance
| Brightness adjustment 'E]|
S AR 0.00
|Whil: balance adjustment ®| Bas'g
BN T R
[ Shot settings Hv}( Tune... )
: ; Advanced
R =] Operation
| Standard h?wi( Browse... )
e
= /B Advanced
y Image Editing
' e . B and Printing
S e
Contrast: .
wi‘m_s et Processing
e Large Numbers
{Cnrillurmni. A B Of |mageS
Col ion:
(OJN e
?’;arpness: e SR PR

Editing JPEG
Images

Reference

(1576, 1021 ) : 157, 165, 189 High quality RAW | Adobe RCE CM,YK% S Index
Information display*? Display mode*# (p.64) CMYK simulation display (p.68)
Image color space*3 and work color space (p.59, p.68) @ @
*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW]. @
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.64) of the
bit conversion). [Preferences] window is displayed.
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List of Tool Palette Functions

RAW Tool Palette (p.21)

BB 6 [#| IMG_oo01.CR2

—————f RAW | RGB  NRiens

|Erighrness adjustmant - |

el e i amags 0-00

White balance adjustment - |
Shot settings | :] ( Tune... j

\

|Picture Style =N

Standard

i s s = :
\_-10.0 -3.0 -6.0 -40 =20 0 20 4.0 )

Contrast:

o) e e
| Linear
|
Color tone:
{0 A
Color saturation:
o TS i
N

sh ? —=
{UZTDI'IESS T A e o

—— Brightness adjustment (p.22)

_ |— White balance adjustment

(p.23, p.24, p.48)

—— Picture Style settings (p.22, p.49)

- Dynamic range adjustment (p.49)

Contrast adjustment (p.25)
Linear setting (p.25)

Color tone and color saturation
adjustment (p.25)

Sharpness adjustment (p.27)

Enlargement display position*!

RGB Tool Palette (p.51)

YRy |#| IMG_0n01.CR2

RaW | RGB | NR/Lens

|Tnne curve assist

Tone curve adjustment ]

PRGN = [ c s ]

(
255

! — e
EﬂghtHESS: .IIIIIII Iml HLT Lk D '«:l
3 —_— F— 0
Contrasy i ..3.. Wi 0]
=\ o
Hue: i B
el il i G
Sharpness:
MURERRIRTIRT!

Automatic adjustment

(@) Z+ B0 )— (tone curve assist) (p.28, p.79)

—— Click white balance (p.81)

- Tone curve adjustment

(p.50, p.83)

- Dynamic range adjustment (p.84)

Brightness and contrast
adjustment (p.80)

Hue and Saturation adjustment
(p.82)

Sharpness adjustment (p.82)

Enlargement display position*!

=1 1f an image is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears when
[Docking display] (p.67) has been set and the edit image window (p.102)

has been enlarged.
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NR/Lens Tool Palette (p.52)
(When a RAW image is selected)

& & & #! IMG_1001.CR2Z
{ RAW  RGB | NR/Lens }
E |
RAW
N
Luminance noise -_-—
v | |
Off Low High
J
N\
Chrominance noise -_-—
Sl | |
off Low High )
TIFF _orJPEG
Chrominance noise
off Low High

e A

Lens aberration correction Tune...
Peripheral illumination OFF
Distortion OFF
Ghromatic aberration OFF
Color blur OFF

Luminance noise reduction for
RAW images (p.52)

Chrominance noise reduction for
RAW images (p.52)

i —— Apply NR button (p.52)

—— Lens aberration correction (p.54)

- Enlargement display position*1

*1 1f an image is displayed enlarged, the enlargement display position
can be moved by dragging. The enlargement display position appears
when [Docking display] (p.67) has been set and the edit image

window (p.102) has been enlarged.

NR/Lens Tool Palette (p.85)

(When a JPEG or TIFF image is selected)

[ Pe  eral illum
Nistoi
rom Er e

Eolor 1 g

RO # IMG_1001.JPG
| RAW  RGB | NRfLens }
E |
RAW
Luminance noise =)
0ff Low High
Chreminance noise B
Off Low High
TIFF or JPEC —_— = Chrominance noise reduction for
Chrominance noise e"_-'T—' | .
o TR Hish ]~ JPEG and TIFF images (p.85)
Aoy i —— Apply NR button (p.85)
| Lens aberration correction |

- Enlargement display position*1
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List of Quick Check Window Functions .15, p.16)

File name of image 50% view/full view*!  Displays the image in full screen*?

Check mark display

~

® ZIISIIMG_DDGZCRZ [3456 x 2304]

| 50% view J [ Full screen ]
Check mark [ Clear J—
(BN - ][ =

( Previous ) ( Next )

Removes check
— marks (p.16)

— Check marks (p.16)

Switches between

Info... j»
| Rotate right |

Rotate left

displayed images

— Displays the image
information window
(p.20)

Image rotation
(90 degree units)

A

*1 In [50% view], you can move the display position by dragging.

*2 To return to the normal screen, press the <es

c> key.

)
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List of Edit Image Window Functions ©.29.p.30)

Shows/hides tool palette

Shows/hides thumbnail display area

Switches to main window (p.96)

Shows/hides grid*4

Image path and file
Enlargement ratio of displayed image
Switches between displayed images

name

Image rotation (90 degree units)

Batch conversion/saving

74, p. 75
@ Digital| Photo Prif | File Edit View Afljustment Tools Window | Help B ) |Ved 3:18 PM @ (p ,p )
E Digital Photo Professional - [ MacOSX/J:| ers/canon/Pictures/Photo/xxxx_xx_xx/IMG_0003.CR2 |
Toolbar
‘ Brightness adjustment
0.00
‘Whi(e balance adjustment La‘”
1] 2 | 3 |(Register. )
Shot settings ) ( Tune... )
‘_l"i:.(ure Style LBJ‘
[ Standard %) ( Browse... )
e | +— Tool palette
CE MY e (p.99)
) ] e (7100 30 --B,H a0 -20 20 40
Thumbnail display area*3 == i R
[ Linear
Color tone: '—6—
o i S
lar
o AR
Sharpness: '—Q—
w Uyl
CMYK
simulation
display
Information display*z {(1258, 1199) : 136, 145, 178 High quality RAW / Adabe RGB CMYK 72— (p68)

Display mode*> (p.64) Image color space*! and work

color space (p.59, p.68)

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.66).
*> The item selected in [Viewing and saving RAW images] (p.64) of the
[Preferences] window is displayed.

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

)
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List of Convert/Save One Image Window Functions

Types of image

(p.34)

Convert and save

| =

Save As: DPP_0O1

Type of image Extension
Exif-JPEG JPG
Exif-TIFF 8bit TIF
TIFF 16bit TIF

Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG

TIFF 16bit+Exif-JPEG | .TIF/.JPG

Resolution*1

File name

Save destination

Where: | [ 7 Photo H4

File format

Kind of file " Exif-JPEG 3

Image quality

JPEG compression rate*3

Output setting i i
3!50 dpi ! Embed ICC profile

Qutput resolution

Size changing*4

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.59, p.68) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to

Resize setting il |
1 Resize
Width Height Lnit
2336

{ 2336 pixel )

3504 gy
{ 3504 pixel )
f Lok asp@ekiratio

Embeds of ICC profiles*? (p.109)

——— Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the

Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.59,
p.68), the ICC profiles are embedded automatically.

longer edge of an image and change its size.
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List of Trimming Window Functions 31 ps0

Cancels the all the trimming (aspect ratio) information

# 1/1 IMG_0001.CR2 [3456 x 2304]

8006 T+ Full screen display/returns to normal screen

—
Full screen

( cear ) ( Resst 1 Reverts to the condition when the image was shot

Fpact ato . | Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*1

3.00 8 2.00

- - = Upper left coordinates of trimmed range (you

— Y 504 . can also enter numerical values)

1':;:‘ = “;;‘-;';" J— Size of trimmed range (you can also enter
82 N numerical values)

(( Copy = |

App lyas

Copies the trimmed range and applies (pastes)
it to another image*2

Pasies

Applies the copied trimming range to all other
images*?2

—— Level of opacity outside a trimmed range

—— Switches between displayed images*?

(1037 ,504) -> (3026, 1830) = ( 1989 x 1326 ) [ 1.50) =

Trimming range Displays borders around a trimmed range

*1 If [Free] has been selected in the [Aspect ratio] list box, you can
also drag the borders of the trimmed range to change its range.

*2 QOperates when you have selected multiple images and the
trimming window is displayed.

)
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S E——

List of Lens Aberration Correction Window Functions 54 .
£ Lens aberration correction )
Contents at
a Glance
Basic
. . Operation
——Enlargement display section*1 ;
Advanced
Reverts to the condition when the Operation
— image was shot
—— Shooting distance information Advanced
slider (p.55) Image Editing
and Printing
—— Peripheral illumination correction
Processing
. ) ) Large Numbers
—— Distortion correction of Images
—— Chromatic aberration correction Editing JPEG
—— Corrects blue chromatic aberration Images
| Color blur Color blur correction
Shows/hides position of
_ Navigator enlargement display section Reference
Grid display
) ok )
Index

Corrects red chromatic aberration

*1 The area you clicked on the image is displayed at 200%. @ @

)

—
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List of Copy Stamp Window Functions .56t p.59 p.sstop.o1)

Introduction

E 1/2 IMG_0050.CR2 [3456 x 2304]
|10k vew || Fullsize view -+— FUIl SCreen display/returns to normal screen Contents at
(oo oust eece 0a —— Applies Dust Delete Data (p.56, p.88) a Glance
(Light) (Dark) )

[ OvO | @O 'L— Type.s'of dust to be erased (p.58, p.90)
~ ... —— Specifies the copy source (p.59, p.91) Basic
_Fix Copy saurce position ——— [jXes the copy source position (p.59, p.91) Operation
{"g::h = ]— Types of stamps (p.59, p.91)

Sets the size of the dust erasure range (p.58,

— p.90) or copy range (p.59, p.91) in arange of 5 Advanced
to 100 (in one pixel units) (you can also enter a Operation

numerical value)
Restores/redoes the image

Copies the dust erasure range or copy range and Advanced

applies (pastes) it to another image Image Editing
PP G ) g and Printing

Switches between displayed images*

Processing
Large Numbers
of Images

Editing JPEG
Images

Reference

7

Set to 100% View to perform stamp operation. -_—

Index

* Operates when you have selected multiple images and the copy

stamp window is displayed. @ @
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List of Convert/Save Multiple Images Window (Batch Processing) Functions .74

File names of images to be

batch saved

| PETET——
IMG_0001.CR2

IMG_0002.CR2
IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2
IMG_0006.CR2
IMG_0007.CR2
IMG_0008.CR2
IMG_0009.CR2
IMG_0010.CR2
IMG_0011.CR2
IMG_0012.CR2
IMG_0013.CR2
IMG_0014.CR2

IMG_0015.CR2
) S —

Batch settings

MacOSX /Users /canon/Documents

[ﬁ.ave.f.ql.der i

r hY
Browse... |
| S ——_

Hkind of file

File format

Exif-JPEG

.;D

Image quality

T 9 10

- Save destination

— JPEG compression rate*3
Resolution*1

Output setting

Output resolution

350 dpi @ Embed ICC profile

7

Resize setting

— Embeds ICC profiles*2 (p.109)

Types of image

Type of image Extension
Exif-JPEG JPG
Exif-TIFF 8bit TIF
TIFF 16bit TIF

Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG

TIFF 16bit+Exif-JPEG | .TIF/.JPG

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.59, p.68) information that is set in an image is attached

to an ICC profile.

Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.59,

.

| Resize
Width Height Unit
3456 L x 2304 pixel 1%
{ 3456 pixel ) { 2304 pixel )
{ W Lack aspect ratis )
[ File Name ]

. Current file name
String

¥} New file name

String Sequence number

DPP_ 0001
Ex.c DPP_ODDL.IPC, DPP_0002,|PG

_| Save sequence number

Size changing*4

7~

=

Image transfer settings

[ Open image using software

File name

Browse...
J

’ Convert RAW images only \ "_'_

Cancel

‘ { Execute }

Batch transfer to other image
editing software (p.75)

Images to be converted are limited to RAW images*>

p.68), the ICC profiles are embedded automatically.

Save

*3 The setting range is 1 to 10. The higher the numerical value, the higher

the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the

longer edge of an image and change its size.
*> Appears when you click the [Batch process] button (p.96, p.102)

without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.
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List of Rename Window Functions .7

Order in which images are sorted

Check mark to apply the same ——

name to RAW images and JPEG
images recorded simultaneously

MacOSX /Users/canon/Pictures/Photo/ xxxx_xx_xx

( File Name

DPP

\

el

e

Extension

B Do not change B
J

Shooting Date/Time 3 Sequence number

~

f Basic Settings

( Format settings

Sort

- "
. File Name

—

L et

%) Fit to main window

Shooting Date/Time

Sequence number

Shooting Date/Time

Month Day Year

( __ Copy & Rename

MM-DD-YY

Check mark to copy the images
Click the [Browse] button and set
the save destination

MacOSX/Users /canon/Desktop

Elnser‘l underbar

0001 | Save sequence number

B
3

R Sl )

Maodified File Maodified File Name

IMG_0001.CR2 DPP_09-13-06_0001.CR2 \

IMG_0001.JPG H |DPP_09—13—DE_DDD?_.JPG U

IMG_0002.CR2 |DPP_09—13—05_0003.CR2

IMG_0002 . JPG DPP_09-13-06_0004.JPCG |

IMG_0003.CR2 DPP_09-13-06_0005.CR2

IMG_0003 JPG — DPP_09-13-06_0006.JPC

IMG_0004.CR2 DPP_09-12-06_0007.CR2

IMG_0004.JPG DPP_09-12-06_0008.JPG

IMG_0005.CR2 DPFP_09-13-06_0009.CR2

IMG_0005.JPG 3 DPP_09-13-06_0010JPC :

—— —_— = i € — — 3 T
( Cancel ) e ‘Execute )

Sets the new file name

Sets the format of information
in the file name

)
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small of even image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
you view on a monitor and the color of an image you have printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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) ) ) Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard .
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in R
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. . -
ColorMatch RGB : A slightly wider color space than sSRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
printing industry, suitable for simulation of ";‘naggﬁgt'it;]”gg
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
Y . .
Rendering intent o images
Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below. »
) . Editing JPEG
Perceptual : Before and after conversion, all colors are Images
Color range that can be converted to maintain the relationship between
seen by the human eye colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors |
. s . ndex
which are similar before and after conversion,
x but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an
value (color temp.) image, you can print a natural-looking image in @ @
— | SRGB 2.2 6500K(D65) which the saturation has not changed greatly.
[ Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K (D65) cases where the overall tone of an image
————- ColorMatch RGB 1.8 5000K(D50) changes somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and hlghllghts Change. 110




Index

A

AdJUSE JPEG IMAQGES ... ittt eeeeeeeeeeeeeeeeeeeeenneeeeees 78

AdjUSt RAW IMAQGES....uuuuiiuriiiiiiiiiiiriiiniirisistssrsssssssessassessssssssseesrnnrnre. 21

AJUSE TIFF TMAQJES. ... uuueiiiiiiiiiiiiiiitiiitiitiiieeeiieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeees 78

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve ASSISt).......ccooeeeieeieciiiieieenns 79
BIIGNINESS ...ttt 80
Click Whit€ BalanCe .......covuiiiiiiiiieeei e 81
(O70] 011 7= 1S R 80
DYNaMIC RANGE .....iviiiiiiieeeieeeeeeeeeeeee e 84
i 10 L= 82
RGB TOOI PAIETE ....veeee e 78, 99
=100 [ = 11T ] o I 82
S =T 0] LSS PPPP 82
Tone Curve AdjUSIMENT......ccooiiei e 83

Adjusting (RAW image)
APPLY AdJUSTMENTS ... 72
Automatic Adjustment (Tone Curve ASSISt).......ccoeeeeieeiieeiiieiieenns 28
BIIGNINESS .ovvieeiiiiiiieiieee ettt a e 22
Click White BalanCe .........cooeiivviiiiiie et ee e 24
(OF0] (o] g Y= 1 (U] 7= 110 ] o 25
(7] (o g =10 0] 0 1=T 7= 10 [ £ < SRR 48
(©F0] (ol 1] £ [T 25
(OF0] [0 YAV g T<T=] T 48
LOF0] 11 =1 SR S 25
(070 o)A AV 18111 41T o £ 72
DyNamiC RANQE.......ccuuuiiiiii e 49
[ L) g 1 (T2 A 26
1Y/ Lo 1 a1 (] 1 1[I 26
Personal White BalanCe ...........oovveiiiiiiiiii e 73
PICIUIE SEYIE e 22
Picture Style File ......uvveiiie e 49
RAW TOOI PaAlBtte ....uncieeceiieeeee e 99
SaVE AGJUSTMENLES ....oiiiiiiieiiiiieeeie e 72
SNAIMPNESS .o 27
Tone Curve AdjUSIMENT........ooiiiiiiiiiieeee e 50
ToninNg EffeCt ..o 26
[ Y0 I 2= 1] 1 (R 11, 99, 100
WHItE BaAlANCE . ccvniieeiie e 23

Adjustment Contents (RECIPE)........uuvvurreerrreriirreeeererereeeeeeereeaneeeees 71, 109
AdODE RGB ... 110
APPIE RGBh...cciiiiiiieieeeeeeee ettt 110
AITaNgE IMAGES ..ot aeaaeeees 17,18
Automatic Adjustment (Tone Curve ASSISt) .......ccvvvevveeiiieiiieiieneen, 28,79
Automatic Dust Erasure Processing.......cccccveeeveeveeeeeeencens. 56, 57, 88, 89
B
Batch Apply White Balance to Images (Personal White Balance)....... 73
Batch Change the File Name of Images.........ccccccevviiiiiiiiiiieeieeeiie 76
Batch Convert/Save Images (Batch Process) .......ccccccceeeevieeeeeeveeinnnnnn, 74
Batch Process (Batch Save JPEG and TIFF Images)................. 74, 107
Batch Process of Multiple Images
Change File NaMEe ........coooiiiiiiiii e 76
Convert/Save (BatCh ProCeSS).........uuuvvvvvvrveevrrrrierererrrensnennns 74, 107
Personal White BalanCe.............ccooiiiiiiiiiiiiiiiiiiiieee e 73
RECIPE DALA ....covveeiiiiiiiiiiiiiieee 71
L= 105 = 75
Batch Settings WINAOW..........cccooiiiiiiiee 74, 75, 107
Batch Transfer IMages .........cccoceeuuiuuuiiiiiiiiiiiiiiieiiiieiveereveee e 75
Batch Transfer Images to Image Editing Software.............c.ccccoeeivnnen. 75
Before/After Comparison DisSplay .............eeeuviiieeviriiiiiiieeieeeiineeeeeeeeeeen, 45
DIt NUMDET ... e e, 109
BOOKMArK ... 43
BIIgNINESS ... 22, 80
C
Change File Name.........cooooiiiii s 76
Changing the File Name of Images in the Order in the Main Window.. 76
CheCk Mark ......cooooiiie e 16, 17, 97, 101
Chromatic Aberration COrreCtion ..........ccoeeeeieeiieeieeee e 54
Chrominance Noise Reduction (JPEG, TIFF Images)......cccccccceeeeennnn. 85
Chrominance Noise Reduction (RAW IMages) .........ccccuvvveeeeeiniiiinnnnn. 52
Click White BalanCe..........ccoooiiiiiiiii 24,81
CMYK SIMUIALION ©.iivniiii et e e 68, 69, 110
(©70] (o] g =[] G @0 f=Tox 1 o] o O RPRRR 54
(070] (o] g @4 4 T- T AR TRTTOPU PR 110
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Color Management (Color Matching)...........ccooeeeee e 109
Color Setting of the Monitor (Profiles) ..., 68
Color Setting of the Printer (Profiles).........ccccccceiviiiiiiiienneenn. 68, 69
[O70] (o gS] o 7= Tol = TP 110
[CC PIOfilES .. 109

Color Management (PreferenCes)......ccccueveevieeeeiiiiiii e 68

Color SAtUIALiON .....cceiieeeee e, 25

Color Setting of the Monitor (Profiles).......c.covvviiiiiiiiiiee e, 68

Color Setting of the Printer (Profiles) .........cccocoviiiiiiiiiiiiiiiiieeeee, 68, 69

COlON SPACE ...uui e 110
AdODE RGB ... 110
APPIE RGB ... 110
Color Space Setting for Each Image ...........ccccvvvevvevviveieeeeieeeveene, 59
(O] (o 141V =1 (od o 1 2 L €1 = SRR 110
Default Setting of Color SPace .......ccoovvvveviiiiiiiii 68
SRGB ... aaaan 110
Wide Gamut RGB........oooiiiiii 110

Color Space Setting for Each Image...........cccccoeei, 59

Color TEMPEIAIUIE.....ceeieeeieee e 48

(0] o] g o] o 1= 2SR PSPPI 25

COolor WHEEI ..o 48

COolOrMAatCh RGB......cooiiiiiiiiiiie e 110

Compatible Cameras with the Lens Aberration Correction Function.. 53

Compatible Lenses with the Lens Aberration Correction Function..... 58

Contact Sheet Printing (Printing a Thumbnail List)............................. 61

CONIIAST .ottt 25,80

Convert to JPEG or TIFF Image and Save................... 34,74, 103, 107

Convert/save One Image Window ..., 34,103

Copy Stamp (Image CorreCtion) ........cceeeeeeeeeeeeeiiiiiii e eee e e 59, 91

Copy Stamp WIiNdow .........cccoovvieiiiiiiiiieee 56, 58, 88, 90, 106

Copying and Pasting (Applying) RECIPES........ccceiiiiiieiiieeiiiiiee e 72

Correct Images (Copy Stamp Function) ...........cceeeeeeeiieen, 59, 91

Creating @ FOIEN .......oeeeiii e e 41

D

Default Setting Of COIOr SPACE........uuuuiuiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeee 68

(D=1 o] o [ g F= Vo [PPSR 41

Deleting
Delete IMAGES .....eeiiiieeiiiie et 41
Delete the Software ..., 95
Deleting DPP (UNIiNStalling) ............uuuuuumiimiiiiiiiiiiiiiieiiieeeeessesereeeeeeeeeeee 95
Detailed Setting Printing (Printing with Shooting Information)............. 60
Display
Before/After Comparison Display ..o, 45
Enlarged Display (Edit WINdOW) ..., 10, 98
Enlarged Display (Quick Check Window) ............cccevveeeennnne 15, 101
Shooting Information Display ..............uevveviieeiieeiiiiiieeiieiieeeeeeee, 9,20
Single IMage DiSPIAY ........uvvveiieiiiiiiiiiiieiieeieeeeeeeeeeeee e 19
Synchronize Edit WINAOW ............cuveeivieiiiiiiiiieeiieeeeeeeeeeeeee e 46
Thumbnail Display (Main Window).............cccveveeeieiiniiiiineeeeenn 9, 96
Thumbnail Display and Enlarged Display (Edit Image Window)... 29, 102
Distortion COrrECHION ... ......eiieeee e 54
Downloading an Image to Your COMPULET ..........eeevvvvveeeeeerrereeenerenrnnenne. 6
Downloading Images from a Camera ..........ccccvevveeeeiiiiiiiiiiieeeeees 6
Downloading Images from a Card Reader....................ccceoeeeeee. 8
Downloading IMaAgES .......ccccuuuuuuueiiiiiiiiiiiiiriiiieiiaeeraeeereereeeeanereee e 6
Downloading Images from a Camera..........cccevveeeeiiiiiiiiieiie e 6
Downloading Images from a Card Reader .............cccvvvvvvvvvvvveeevnnnnnnnnee. 8
DUSEt DEIEte Data .....cceuieiviiiiieeee e 56, 57, 88, 89
Dust Erasure Processing
Automatic Dust Erasure Processing ........ccceeeeeeeienennnnnnnnnnnnnnns 56, 88
Image Correction (Copy Stamp Function) ..........cccccevvvivvnnnee. 59, 91
Manual Dust Erasure (Repair Function) ..................c.oeeeee. 58, 90
DYyNamiC RANQE ......ciiii e e e e e e eannn 49, 84
E
Edit IMage WINAOW..........uuuuuiiiiiiiiiiiiiiiiiiiieeiieeieeeeeeeeeeeeeeeeeeeeeeeeees 29, 102
Edit WINAOW. ...t 10, 98
EdItiNg. ..o - Adjusting
Enlarged Display (Edit WINAOW) .........ccuuviiiiiiiiieiiieeciene e 10, 98
Enlarged Display (Quick Check Window)...........ccccoviiiiiiiiiiieenniiiiee 101
EOS ULIIEY «.eveeeieee et 6,7
F
False Color REAUCHION ......cciiiiiiiiiiiiiiice et 64, 65
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FIEEE EFfECT. . .eiiiiiie i 26
G
General Settings (PreferenCes) ........uuvvvieeiiiiiiiiiiiiiceee e 64
H
= o PP PPPPPRP Cover
Highlight Area Warning INdicator ...............uvvvvvvvviiiviieeiieeiirreeeereeeeneeeee. 47
HUB et e e e e e aeas 82
I
[CC PrOfIlES .. 109
Image Frame Information (Image Marks) ..........cccccueevveeeeieieeeieeennnnnne. 97
Image Marks (Image Frame Information) ............cccccevvvevvvvveeeeeeeveennnen, 97
Image Quality
False Color RedUCHION ..........cuviiiiiieieieiiieeee e 64, 65
Improve the Quality of an Image (Main Window) ............cc..vvvueen. 20
Noise Reduction of a JPEG Image (Chrominance)...................... 85
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 52
View and Save a RAW Image ... 64, 65
Image Shooting Information DiSplay ...............uvvvvvivvviiiiiiiiiiiiriinnnnn. 9, 20
Improve the Quality of an Image (Main Window) ...........ccccvvveveeeieenneen. 20
J
N1 L N [ 1= o 1 109
L
Lens Aberration COrrECHION .......ccooeeiiieieeee e nnneeeees 53
Lens Aberration Correction WiNAOW .........covvvieiiieeiiiiieeieeiieeenn, 54, 105
[ a1 TP PUPPPRRUPPPTN 25
Loading and Pasting (Applying) RECIPES .....cceveevvvveiiiiiii e, 72
Luminance Noise Reduction (RAW IMages) ........ccccvvvvreeeeiiiiiiiinennenn. 52
M
Y/ T AT AT o Lo LA 9, 96
Manual Dust Erasure (Repair FUNCLION) ........covvvvvvieieeiiieiiienieeeeee, 58, 90
MONOCKHIOME ... e 26
FIlter EffECE ...t 26
TONING EffECT ... 26
Move Or COpY FOIAEIS......cooeeiie e e 42

MoVe OF COPY IMAGES ...coiieeeiiiiiei et e e 42
N
Noise Reduction (JPEG or TIFF IMage).......cccuvveeeiriiiiiiiiiieeeee e 85
Noise Reduction (RAW IMAQJE) .....uuuuuriimiiiiiiiiiiiiiiieiieeieeeeeeeeeee e 52
Noise Reduction of a JPEG Image (Chrominance)...........cccccceevunnnee. 85
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 52
NR/LENS TOOI PAlELe .........uuiiiiiiii e 100
@)
Organize IMaAgES ....cooeeeeeeeeee e 41
Organizing IMAGES ..ccccuurreieieeeei ittt e e 41
Create @ FOIUBN ... ittt 41
Delete IMagesS....cooovvviiie e 41
Move or Copy FOIders..........coovviiiiii 42
MOoVE OF COPY IMABGES .....uuuiie et 42
Register Folders as BoOKMarks...........ccccceeviiiiiiiiiieiieeseiiiiee 43
P
Peripheral lllumination COorreCtion .............cccvvvveeeeiiiniiiieieeeee e 54
Personal White BalanCe ............ccuvviviiiiiiiiiiiiiee e 73
PICTUIE SEYIE ... e 22
Picture Style File......ccoo oo 49
Prefer@NCES ...t ee e 64
(7] (o Tl 1Y/ = TaT= To [T 1 41T o | APPSR 68
General SEINGS ..vvvvvieiei e 64
TOOI Palette ... ..o 67
VIBW SENGS oo 66
Printing
Printing a Thumbnail List (Contact Sheet Printing) ...............ovuen... 61
Printing One Sheet of Paper.......cccccceeeivieeviieiiciie e, 13, 40
Printing with a High-End Canon Printer .............ccccccc. 62
Printing with a Large-Format Canon Printer ...........cccccoovvvivinennnn. 63
Printing with a Printer other than the Canon Printers.................... 40
Printing with Canon Inkjet Printers...............ccccee, 35, 38
Printing with Easy-PhotoPrint ..o, 38
Printing with Easy-PhotoPrint EX.......c.cccoovvviiiiiiiiiii e, 35
Printing with Easy-PhotoPrint Pro..........cccccoeei 62
Printing with Shooting Information (Detailed Setting Printing) ...... 60
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Rendering Intents when Using Easy-PhotoPrint ................... 68, 69
Printing a Thumbnail List (Contact Sheet Printing) .............cccevvvvvvnnnnn. 61
Printing One Sheet of Paper...........oviiiiiiiiiiiiieeiieee e 13,40
Printing with a High-End Canon Printer ...........ccccvvvvviiiiii e, 62
Printing with a Large-Format Canon Printer ...........ccccccceeeviiiiiiiinnneenn. 63
Printing with a Printer other than the Canon Printers............ccccvvveen.. 40
Printing with Canon Inkjet Printers...........ccccovvveeeiiiiiiiiece e 35, 38
Printing with Easy-PhotoPrint ..o, 38
Printing with Easy-PhotoPrint EX..........cccuviiiiiiiiiiiiiccece e 35
Printing with Easy-PhotoPrint Pro...........cccccovviieeiiiiiiiiii e, 62
Printing with Shooting Information (Detailed Setting Printing) ............ 60
Q
QUICK CheCK WINAOW.......uiiiiiiiiiieeiie e 15, 101
QUITLING DPP .o 13
R
RAW IMAGE. .. 109
RAW TOOI PalEIE .....euiiiiiiiiii e 11, 99
Re-Adjusting @n IMAJE .......uuuuuiuiiiiiiiiiiiiieiiiiiieeeeeeeeee e eeeeeeereeeeeeeas 35, 92
RECIPE .. e e e aaanne 71,109
RECIPE FlE .. e e 71
Re-Editing an IMage ........oovvviiiiiiiie e e e e e neaanes 35, 92
Registering Folders as BOOKMArks...........ccccvvvviiiiiiiiiiiiiiicce i 43
ReName WINAOW............uuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeieeieeeeeeeeeeeeeeeeenes 76,108
Rendering Intent (Matching Method) ... 110

Rendering Intents when Using Easy-PhotoPrint .................... 68, 69
Rendering Intents when Using Easy-PhotoPrint...........cccccc..co...... 68, 69
Repair (Manual DUSE Erasure) ..........ccooueiviieieeeeenniiiiiiieeeeee s 58, 90
RGB TOOI PalELe .......uveiiiieeiiiiiiiiiieeee e 78, 99
RoOtate IMages........oviiiiiiiieeiiei e 9, 21, 96, 101, 102
S
SAUrALION....eei i 82
Save

Batch Convert/Save Images (Batch Process)...................... 74, 107

Convert to JPEG or TIFF Images and Save...........cccc.eeee..... 34, 103

SV Lttt ettt ettt ettt e e e e e e eees 33,91
SV A 33,91
Save JPEG or TIFF Image as a Separate Image .............c........... 92
View and Save RAW IMages.......ccooeeeeeeiiiiiieeiees 64, 65
S T= AV ST 33,91
SAVING RECIPES. ... et 72
SeleCt IMAgES....ccoveeiieeieeeee 9, 15, 29
Shadow Area Warning INdiCatOr...........cceeviieiiiiieiiiiiee e 47
SNAIMPNESS ... 27,82
Shooting Information DiSplay...........ccuuuiiiiiieeiiieeeiee e 9, 20
SNOMCUL KEYS ...ttt Cover
Single Image Display ...........coooo i, 19
Single Image Display of RAW and JPEG Image..........ccccceveeeeiiiinnen. 19
Sorting Images (Check Marks) ...........cccccoeeeiei, 16, 17
RS 1= PRSPPI 110
Starting UPp DPP ..., 6
SUPPOIEA IMBGES ...t 3
Synchronization (Edit WindOW)............coooooiiiiiiii e, 46
Synchronize Edit WINAOWS ..........couiiiiiiiiiiiieeee e 46
SYNChronize IMAagES ........coooo e 46
SySteM REQUITEMENTS .....ueiiiiiiiiiiiiiiii et 3
T
Thumbnail Display (Main Window) .........ccoovviiiiiiiiiiiieeeeeeee 9, 96
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Thumbnail Display and Enlarged Display (Edit Image Window) ......... 29
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Tool Palette (PreferenCes) ........cuuvevieeiiiiiiiiiiiiiieiiieiieee et 67
Transfer
Batch Transfer Images to Image Editing Software...................... 75
Transfer an Image to Photoshop............ccceeiviiiiiiviciiice e 59
Transfer an Image to PhotoShOp ...........oovvvviiiiiiiiiiieeceeee 59
TAMMING @N IMAJE ...evvviiiiiiiieiiiiieeeeeeeeiee e e e e e aeeeeeeeeees 31, 86
TrmMMING WINAOW ......uvviiiiiiiiiiiiiiiiiiiiiiieeieeieeeeeeeeeeeeeeeeeeeeeee 31, 86, 104
\%
View Settings (PreferenCes) .........uuvvvvviiriiiiiiiiiiiiiiiriieeeeereissseeeseeenneeen 66
W
WHhite BalanCe.........uuiiiiiiiiiiece e e 23
Click White BalanCe .............uuuuuiiuiiiiiiiiiiieiiiieiiiieieeeeeeeeeeeeeeeeee 24,81
COlOr TEMPEIALUIE ....ceeiiiiiiiieeee e 48
COlOr WREEI.....eiiiiiiiiiiiiii e e e eeas 48
Personal White BalanCe .........c.cccccvvvvviiiiii 73
Wide GamUEt RGB ........uiiiiiiiiiiiiiiiiiecce et 110
WOTK COlOr SPACE......eeiiiiiiiiiiiiii e 59

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

© Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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